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1. Introduction 
 

This manual has been written to accompany the Bentham PVE300 photovoltaic characterisation 

system, and aid in the use of the system and the control software, BenWin+. 

 

Sections 2 to 9 discuss the system component hardware, 10 the software, and in sections 11-14 is 

provided a guide to the measurement of spectral responsivity/EQE, and spectral 

reflectance/transmittance used in the determination of IQE. 

 

A precautionary note and troubleshooting help is provided in section 15. 

 

In the appendices are to be found background information deemed to be of interest, including a note 

on system installation. 

 

1.1 System Configuration 

 

A monochromatic probe source, 300-1800nm, is assembled from a dual xenon/quartz halogen light 

source. 

 

This source, with appropriate accessories and reference standards, is used to determine the spectral 

responsivity, reflectance and transmittance of devices under test. 

 

The conditions of measurement and signal recovery depends upon the material system under 

consideration, as discussed in §11. 

 

A temperature controlled vacuum mount is provided to ensure that the measurement is made under 

temperature controlled standard conditions, and to set the device under test (and reference detector) 

at the measurement plane. 

 

An integrating sphere is used to perform measurements of sample transmittance and reflectance. 
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2. Dual Light Source 
 

2.1 Introduction 

 

 

Figure 2.1: Dual Source 

 

The probe light source here employed is a dual xenon/quartz halogen source having a computer 

controlled swing away mirror between them to permit selection as a function of wavelength and an 

arrestable optical chopper to provide an AC probe signal. 

 

Whilst the xenon source provides higher output throughout the visible, this is accompanied with 

unstable line emission. The quartz halogen lamp, despite its lower output, represents a very stable 

source up to 3µm. 

 

In effect, the system operates in a mode in which the instability of the xenon lamp is taken account, 

the recommended cross over point between xenon and QH lamp use is 800nm. 

 

Note that the dual housing has a fan situated to one side. This fan should be connected to the 610 at 

all times and should be powered on when the source is in use. 
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Figure 2.2: Relative output of xenon and quartz halogen lamps 

 

 

NOTES:  

 

1. The lamp housing becomes hot during operation. 

2. On powering up the xenon lamp, a starter drops a high voltage across the electrodes to 

commence the arc. It has been seen that this discharge can damage other electronics. It is 

recommended where possible to switch on all discharge sources first before 

monochromator and electronics.  

 

2.2 Xenon short arc lamp 

 

The output from the 75W xenon lamp is coupled to the monochromator via an off-axis parabolic 

reflector. The output is coupled to the monochromator save when the SAM is activated to couple light 

from the QH lamp. 

 

This lamp should be operated at 5.40A with a Bentham 610 supply. The 610 destined for use with this 

lamp is indicated. Lamp life is estimated at around 1000hrs. 

 

2.3 Quartz Halogen Lamp 

 

The output from the 100W quartz halogen lamp is coupled to the monochromator via an arrangement 

of condenser lenses. The output is selected when the SAM is energised, in which case the latter also 

blocks the light issued from the Xenon lamp from reaching the monochromator. 

 

This lamp should be operated at 8.50A with a Bentham 610 supply. The 610 destined for use with this 

lamp is indicated. 

 

 

 

2.4 610 Constant Current Supply 

 

2.4.1 Introduction 

 
A rotary switch provides 5 calibrated pre-set current settings; 4.00 A, 5.40 A, 6.30 A, 8.50 A, 10.40 A. 

Users also have access to a variable output ranging from 0 to 10.4 A, PC setting where users can control 

the unit via the USB port on the rear of the unit.  
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Figure 2.3: 610 supply 

 

Temperature 

stability 

30 ppm/°C 

Indications Green LED= Power on 

Red LED = Lamp failure 

Front panel 

meter 

Output voltage indicator 

Fan output 12V ac (typically 200mA) 

Mains input 

voltage: 

Back panel switch to select nominal 

110V or 220/240-V ac 

Mains 

frequency 

50 or 60 Hz 

Mains input 

fuse 

220/240V 2.5A Anti-surge 

110V 5A Anti-surge 

Table 2.1: 610 specifications 

 
A socket for lamp fan operation is situated on the lower right of the front panel. 

 
2.4.2 Setting up mains voltage 

 

Whilst the mains voltage is set up at Bentham according to where the device is sent, it is of good 

practice to verify before powering up the 610. 

 

A toggle selector should be found underneath the mains connector to the rear of the 610. Please 

ensure that the voltage of the country in which the 610 is to be used is displayed. 
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Figure 2.4: Voltage selector displaying voltage in use 

 

At Bentham, the appropriate fuse (plus a supplement) is fitted. Should the voltage setting be wrong, 

please ensure that the correct fuse is installed.  

 
2.4.3 Lamp Operation 

 

 Ensure fan is connected and power on 

 Use the rotary switch on the 610 to select the current required 

 Should the required current not appear as a pre-set value, use the adjustable dial on the right 

hand side and select that channel 

Operating conditions are as follows: 

 

Source Current (A) 

100W QH lamp 8.500 

75W Xenon lamp 5.400 

50W QH lamp 

(solar simulator) 

4.000 

Table 2.2: Lamp current settings 

 

Depress the output button to illuminate/extinguish the lamp 

 

2.4.4 Operation Notes 

 

For correct lamp operation, please respect the following: 

 

 Please ensure the correct polarity is respected at all times, connecting red to red and black to 

black from lamp to 610 

 Always ensure that the fan is connected to the 610 

 Do not touch bulb with bare fingers. 
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 Do not run the lamp at a current lower than that at which it is specified. Under-running a quartz 

halogen lamp can curtail lifetime by breaking down halogen cycle. 

 The lamp requires approximately ten minutes warm-up time 

 

Furthermore, it is of use to note the voltage displayed on the 610 LCD. This is for indication only, but 

can be used to determine lamp condition1. Quartz halogen lamps are operated at slightly under their 

nominal rating, and as such the voltage readings may be lower than nominal. 

 
  

                                                           
 
1One of the failure mechanisms of such lamps is “bridging” or short-circuit of part of the filament, leading to a correspondingly lower 
voltage and reduced light output. 
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3. Monochromator 
 

3.1 Monochromator operation 
 

No light source is truly monochromatic, i.e. does not contain light of solely a single wavelength. All 

sources contain contributions from a finite range of wavelengths, namely its’ spectrum. 

 

A monochromator is a device which permits the determination of the spectral output of a source by 

separation and measurement of the component wavelengths. 

 

3.2 Wavelength Dispersion 
 

The simplest means of resolving component wavelengths is that seen when, for example, sunlight 

shines through raindrops to create a rainbow. 

 

The apparently “white” light from the sun, on travelling through the droplet is refracted, or bent. The 

amount light is refracted depends upon its wavelength. Here, blue light on one extreme of the visible 

spectrum is refracted more than red light on the other extreme, resulting in a rainbow. In effect the 

sun contains wavelength components from the UV to the infra-red (heat radiation). 

  

Wavelength separation in an analogous manner, using a prism, may be employed in a 

monochromator, yet has practical implications, namely due to material absorption of the incident light 

and the limited wavelength range of operation. 

 

The preferred means of wavelength dispersion is by use of diffraction gratings. 

 

3.3 Diffraction from a grating 
 

In Bentham monochromators, diffraction gratings are used for wavelength dispersion. Rather than 

using the refraction of light, diffraction gratings depend on the diffraction, or interference of light. 

 

Diffraction gratings can come in two forms, reflection or transmission gratings. Since it is the former 

that are employed in Bentham monochromators, here shall be considered this specific case. 

 

A diffraction grating is effectively a surface which, on the microscopic scale, contains a vast number 

of “terraces”, or grooves, separated by a distance comparable to the wavelength of light to be 

considered. Bentham uses gratings with a “groove density” from 75- 2400 grooves per millimetre. 

 

On shining light upon this surface, each terrace acts as a narrow slit-shaped source. It is the 

interference of the light from these sources that is of interest. 

 

Diffraction can be visualised by the following, whereby light of wavelength λ is incident at an angle α 

to the normal of a diffraction grating of groove spacing, d. Light is diffracted along angles βm into a 

number, m, of diffraction orders. 
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Figure 3.1: Plane reflection grating diffraction 

 

Now, it is known that light in can behave like a wave. When two wave peaks are coincident, results a 

larger peak, the inverse in the case of troughs. In between these extremes, vary amounts of 

interference occur. 

 

A sign convention exists for the definition of angles and orders. In general angles are measured from 

the grating normal to the incident wavefront. Should diffraction occur on the opposite side of the 

grating normal, then negative angles are used. 

 

This view can be simplified to the following, where one can consider two adjacent grooves separated 

by a distance, d. 

 

 

Figure 3.2: Path difference between neighbouring rays 

 

The geometrical path difference, Δ, between the path of the incident wavefront between A and B and 

the diffracted wavefront between C and D is  

 

Δ = AB + CD = d sin α + d sin β 
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Now, for constructive interference to obtain, adjacent rays must differ by integer number of 

wavelengths. This leads to the grating equation. 

 

)sin(sin   dm  

 

or 

 

 sinsin Gm  

 

where G is the groove density, G= 1/d. 

 

For a given incidence angle α, there shall therefore be a set of discrete angles for which constructive 

interference shall be observed. At all other angles, there will be some measure of destructive 

interference. Here m is the diffraction order and is an integer. 

 

Since the absolute value of the sine function cannot exceed unity, then: 

 

2|/| dm  

 

For a particular wavelength the above gives the possible diffraction orders present. 

 

Specular reflection (α =β) always exists, this is the m=0, zero order position, where the grating simply 

acts as a mirror and the component wavelengths of the incident wavefront are not separated. 

 

In Bentham monochromators, the grating is rotated as a function of wavelength,  

about a pivot coincident with the central ruling, to scan through wavelengths. The direction of the 

incident and diffracted light remains therefore unchanged. 

 

In this case, one refers to the angular deviation, 2K, between the incidence and diffraction directions, 

defined as: 

 

2K = a – β = constant 

 

Further defined is the scan angle, φ, measured from grating normal to the dissector of the beams 

 

2 φ = a + β 

 

Now, substituting, the grating equation becomes: 

 

 sincos2 Kdm   

 

For a given monochromator K is a constant, therefore one can determine select a wavelength by 

determining the required grating angle. 
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3.4 Diffraction orders 
 

As noted above, the grating equation may be satisfied at a given angle by a number of wavelengths of 

different diffraction orders. 

 

 

Figure 3.3: Existence of diffraction orders 

 

This can lead to problems when attempting to measure light in a given diffraction order, when the 

detection system is capable of sensing the wavelength in the next diffraction order etc. 

 

Order sorting is therefore required, and consists of the filtering of the monochromator input with long 

pass filters where higher diffraction orders might be present. 

 

This also leads to on explanation for measurement in first order. The wavelength of light that diffracts 

along the direction of λ1 in order m+1, is λ1+Δλ, where 

 

11

1


m

m 
  

 

Hence we define the free spectral range, the range of wavelengths over which overlapping of adjacent 

orders does not occur, 

m
F 1   

 

3.5 Diffraction grating production 
 

Gratings found in monochromators are replicas based on master gratings. 

 

Master diffraction gratings are produced by one of two means: 

 

1. Holographic exposure then chemical etch of grooves 
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2. Mechanical ruling of grooves 

 

In the holographic technique a substrate is covered with a photoresist material whose properties 

change under light stimulation. Exposure to an interference pattern defines the grating outlay, 

chemical etching is then employed to selectively etch the substrate as a function of the photoresist. 

 

This method produces almost sinusoidal grooves, but of very high surface quality. 

 

The mechanical technique involves the mechanical inscribing, using a diamond tip in a “ruling engine” 

to define grooves on a metal substrate, a lengthy and difficult process. 

 

This method yields very good, triangular grooves, resulting in gratings of very high efficiency. However, 

surface defects may have an impact in certain cases by introducing stray light into the 

monochromator. 

 

 

Figure 3.4: Groove shape obtained using ruling (upper) and holographic techniques 

 

Replica gratings are resin casting of master gratings, on a glass substrate, which are then coated by a 

suitable metallic coating for the spectral range of use, such as aluminium. 

 

Diffraction gratings may be produced on flat (plane) or non-flat (for example concave) substrates. 

 

3.6 Diffraction grating efficiency 
 

The efficiency of a grating is defined as the power of monochromatic light diffracted into a given order 

relative to that light incident. 

 

In order to increase the efficiency of a grating at a given wavelength, the angle of the grooves is 

designed such that the specular reflection from the grating surface lies in the same direction as that 

wavelength in question.  

 

This procedure is called blazing, the peak wavelength being the blaze wavelength. 
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Figure 3.5: Example grating efficiency curves 

 

The consideration of grating efficiency becomes more complicated when one considers polarised 

incident light, and in particular the case of TM polarised light in which case the electric field vector is 

perpendicular to the grooves, giving rise to anomalies, or abrupt changes in the grating efficiency 

curve. 

 

3.7 Czerny-Turner Monochromator 

The Czerny-Turner configuration, as employed in Bentham monochromators, uses a plane diffraction 

grating. 

 

 

Figure 3.6: Czerny-Turner configuration 

 

In order to control the location of diffracted light, the grating should be illuminated by collimated light. 

Incident light, diverging from an entrance slit is collimated by a first concave mirror. After diffraction 
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from the grating, light is focussed to an exit slit by a second concave mirror. As a function of 

wavelength therefore, the grating is rotated to scan through a spectral range. 

 

 

3.8 Stepping motor drives 
 

It has been seen that in fixed angle monochromators, it is of question to move the diffraction grating 

through a range of angles in a repeatable manner. To this end, stepping motors are employed. 

 

A stepper motor is a type of electric motor that moves in increments, or steps, rather than turning 

smoothly as a conventional motor does. The size of the increment is measured in degrees and can 

vary depending on the application. Typical increments are 0.9 or 1.8 degrees, with 400 or 200 

increments thus representing a full circle. The speed of the motor is determined by the time delay 

between each incremental movement.  

 

Inside the device, sets of coils produce magnetic fields that interact with the fields of permanent 

magnets. The coils are switched on and off in a specific sequence to cause the motor shaft to turn 

through the desired angle. The motor can operate in either direction. 

When a current is passed through the coils of a stepper motor, the rotor shaft turns to a certain 

position and then stays there unless or until different coils are energized. 

Unlike a conventional motor, the stepper motor resists external torque applied to the shaft once the 

shaft has come to rest with current applied. This resistance is called holding torque. 

Stepping motors, combined with gear systems or sine-bar mechanisms are used to provide high 

precision and highly repeatable monochromators. 

 

3.9 Double monochromators 
 

When using a single monochromator such as that shown in figure 3.6, it is possible that light, entering 

from the entrance slit, be scattered off the walls and structures constituting the monochromator, 

reach the exit slit. Therefore, at a given wavelength, λ, an artificially high signal is measured.  

 

This is termed stray light and is of concern where low light level measurements are performed where 

there exists a significant light component at other wavelengths. Classical examples are measurements 

of UV sources and high optical density filter transmission. 

 

Consider for example the measurement of a quartz halogen lamp, a lamp often used as calibration 

standard. The following figure demonstrates the effect of scattered light in measuring the lamp UV 

output where there exists a significant amount of visible light. 
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Figure 3.7: Measurement of QH lamp with single and double monochromators 

 

A double monochromator situates a second single monochromator at the exit of the first. 

 

Entering the first monochromator is all the light from the source to be measured; entering the second 

monochromator is the wavelength selected and a level of stray light, which one desires to reduce. 

 

In the second monochromator, the desired wavelength re-selected; at the exit slit one finds that the 

level of the stray light has reduced to the square of the case of the single, for example a factor 103 

down in a single, a factor 106 down in a double. 

 

There are two possible configurations of double monochromator; with additive or subtractive 

dispersion. 

 

With additive dispersion, the first monochromator is followed by a device of similar type. The band of 

light transmitted from the first to second is further dispersed, resulting in twice the dispersion of a 

single system; for a given required bandwidth therefore, the monochromator slits may be doubled in 

size with respect to a single monochromator, which increases the system throughput. 

 

With subtractive dispersion, the second monochromator is operated in an inverse manner to the first 

in such a manner that at the exit slit there exists no net dispersion. 

 

At the exit of the first monochromator, the light to be transmitted to the second monochromator is 

dispersed across the slit; at the exit of the second monochromator this dispersion does not exist and 

all the wavelengths are combined. The dispersion of a subtractive double monochromator therefore 

is the same as that of a single monochromator.  

 

The subtractive configuration is often employed in such systems as primary transfer standard where 

the uncertainty of dispersion across the detector slit is unacceptable (yet for most applications of no 

real consequence). 

 

A further important point is that of the slits of the double monochromator. 
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With additive dispersion, it is the entrance and exit slits which define the system bandwidth, the 

middle slit between the two monochromators being employed to reduce the stray light being 

transmitted to the second element. The middle slit should be at least twenty percent larger than the 

largest slit of the system to prevent tracking problems (beating) between the two component 

monochromators. 

 

With subtractive dispersion, it is the entrance and middle slits which define the system bandwidth; 

the exit slit is employed to reduce the system stray light and again should be at least twenty percent 

larger than the largest slit of the system. 

 

3.10 Wavelength calibration 
 

The TM family of monochromators contain a turret (per monochromator) upon which can be mounted 

up to three diffraction gratings. 

 

The turret is driven through a reduction gear from a stepping motor which is used in the micro-

stepping mode, yielding an angular resolution of 0.00072 per step which corresponds to 500,000 

steps per revolution of the turret 

 

Each monochromator includes a two-stage encoder which allows the unit to be sent to a fixed point 

(negative limit) which is used as a datum. On software initialisation, the turret is sent to this “park” 

position. 

 

For each grating, is provided two parameters; the first is the number of steps which must be made 

from the datum position to reach the nominal zero order position for that grating (zord), the second 

is a scaling factor (value near 1) which gives the best wavelength linearity (alpha). 

 

For systems having multiple exit ports, by use of swing away mirrors (SAMs), setup involves ensuring 

the good calibration of all ports with one set of grating parameters.  

 

The results of the wavelength calibration (zord and alpha per grating) is provided for all 

monochromator exit slits. 

 

By far the most useful wavelength calibration source is the mercury lamp, the spectrum of which 

contains a large number of discrete emission lines in the UV- visible domain, the wavelength of which 

never change. 

 

It is worth noting that in the case of high pressure mercury lamps, the lines may be broadened with 

respect to those emitted from a lower pressure lamp. Values are given in appendix 1. 

 

In spectroradiometry, the first order contribution is most commonly used, however, for purposes of 

wavelength calibration, higher order contributions may be of use. 
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Furthermore, in the case of gratings for use in the infra-red, where there exists no useful contribution 

from the mercury lamp output, the zero-order position is used to set up gratings, in which case light 

incident on the entrance slit is transmits directly to the exit slit. 

 

In effect the mercury spectrum is virtually omnipresent to a certain extent in the laboratory 

environment, overhead fluorescent tubes containing some of this vapour. 

 

Alternative calibration sources are lasers or interference filters of known transmission, which may be 

suitable for certain wavelength regions, but do not have such wavelength coverage as the mercury 

lamp. Please see appendix 2 or information concerning checking the wavelength calibration. 

 

3.11 TMc300 Monochromator 
 

The monochromator of this system is a Bentham TM300, 300mm focal length monochromator. 

 

In the TMc300 monochromator, up to three diffraction gratings are mounted on a turret to permit use 

over a wide spectral range.  

 

The turret is driven through a reduction gear from a stepping motor which is used in the micro-

stepping mode, yielding an angular resolution of 0.00072 per step which corresponds to 500,000 

steps per revolution of the turret. 

 

 

Figure 3.8: TMc300-FU monochromator 

 

For each grating is provided two parameters, the first is the number of steps which must be made 

from the datum position to reach the nominal zero order position for that grating (zord), the second 

is a scaling factor (value near 1) which gives the best wavelength linearity (alpha). 

 

The TMc300 includes a two-stage encoder which allows the unit to be sent to a fixed point (negative 

limit) which is used as a datum. On software initialisation, the turret is sent to this position. 

 

A six position order sorting filter wheel is situated behind the entrance slit. 
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There exists in this monochromator two exit ports with a swing away mirror positioned between the 

two. 

 

All ports are fitted with fixed slits to define system bandwidth. 

 

3.12 Diffraction gratings 
 

This system is fitted with the following gratings: 

 

Line density 

(g/mm) 

λ Blaze 

(nm) 

Max λ range 

(nm) 

1200 Ruled 500 300-1100 

600 Ruled 1250 1000-2500 

Table 3.1: Diffraction gratings installed 

 

3.13 Order sorting filter wheel 
 

The governing diffraction equation admits solutions for integer multiples of the wavelength in 

consideration, thus diffraction orders. Most spectroradiometry is performed on the first order 

contribution, it is necessary to avoid measurement of higher order signals for correct measurements. 

 

A six position order sorting filter wheel is to be found on the inside of the monochromator exit port. 

The following filters are fitted: 

 

 

Position Filter Insertion 

(nm) 

1 Open 0 

2 OS400 400 

3 OS700 700 

4 OS1250 1250 

5 Open - 

6 Shutter - 

Table 3.2: Filter wheel content 

 

A blank disk, in position six stops light from entering the monochromator during dark current and 

offset measurements. 
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Figure 3.9: Typical OS filter transmission 

 

 

3.14 Monochromator Bandwidth 
 

The monochromator bandwidth, defined in nm, is the range of wavelengths seen by the detector at 

one time, and is directly linked to the monochromator slits in use. 

 

This is an important quantity to take into account, particularly when measuring sources have fine 

spectral features such as line emission. For example, the measurement of a source having two spectral 

lines one nanometre apart with a system bandwidth of five nanometres, will result in the 

measurement of a single line. In many instances this is of no concern, since the power measured shall 

nevertheless be correct. 

 

The effect of monochromator entrance and exit slits on monochromator bandwidth can be viewed in 

two manners. 

 

In the first instance, the monochromator is an imaging system; the input port is imaged at the exit 

port; the dimension of the monochromator entrance slit defines the image size at the exit port. 

 

Furthermore, since the light incident at the exit of the monochromator is dispersed one can imagine 

the wavelength axis running along parallel to the wall of the exit slit, and the size of this slit determines 

how many wavelengths can be seen at one time. 

 

One can imagine therefore an infinite number of images of the entrance slit of incrementally differing 

wavelength presented parallel to the exit slit; whichever of the two are the largest, defines the 

bandwidth of the system. 

 

In a double monochromator, a further slit is included, the middle slit (in the case of a system having 

additive dispersion). The purpose of this slit is to reduce the amount of stray light going from the first 

to second monochromators and should at all times be set to at least 20% larger than the largest slit in 

the system, else tracking problems between the component monochromators shall result. 
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The slit function of a monochromator provides interesting information with regards to the device 

performance and the system bandwidth; this may be determined by the measurement of a source of 

narrow spectral width, such as a laser. 

 

 

Figure 3.10: Example measurement of slit function 

 

One should perform a measurement at smaller steps than the system bandwidth (for example 0.1nm), 

over a spectral range of around four times the expected bandwidth, centred on the expected 

wavelength of the emission line, for example 632.8nm for the HeNe laser. 

 

The full width half maximum (FWHM) of this spectrum provides the bandwidth of the system. 

Inspecting the signal at one bandwidth, two bandwidths etc. relative to the peak, provides information 

of the stray light performance of the system. 

 

If the entrance and exit slits are of the same dimension, the slit function shall have a triangular profile, 

otherwise, the function shall be flat-topped. 

 

It is worth noting that care should be made in making this measurement as it is not sufficient to shine 

a laser in the entrance slit of the monochromator. This measurement should ideally be performed by 

filling the entrance slit, using an integrating sphere for example and illuminating the sphere with the 

source. 

 

Finally, it follows that slit dimension has an impact of the light throughput of the monochromator. In 

certain instances where a reduction in signal is required, either the entrance or exit slit can be reduced, 

whilst maintaining the same system bandwidth. It is preferable that the slit to be reduced be the exit 

slit to avoid any conflict with the input optic. 

 

It is important to remember that to perform a scan with a step size lower than the bandwidth 

obtained is satisfactory, on the contrary to step larger than the bandwidth results effectively in the 

loss of information. 
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For information, the following table shows the bandwidth obtained for the monochromator and 

gratings of this system with a range of slit widths, those supplied being highlighted. 

 

Fixed slits are changed by the following method, see figure 3.11. 

 

Removing slits: 

 Remove fixed slit cover with M3 Allen key 

 Using pincers, pull out slit in place 

 

Inserting slits: 

 Place slit in holder with etched side facing away from monochromator, flat rear of slit against 

the monochromator 

 Push fixed slit down, firmly into place 

 

It is important that the slits are installed in the correct orientation, else a wavelength error results. 

 

 

   

Figure 3.11: Changing fixed slits along with a table of the slit widths and bandwidths that these produce 
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3.15 Setting mains voltage 
 

The TMc300 is fitted with a switch mode power supply. However, prior to switching on the 

monochromator, please ensure that the line fuses selected are correct for the mains voltage in your 

region. 

 

Whilst the housing is destined to have one orientation (and one fuse) for 110V and another for 240V, 

in practice, the same fuse for the destination region is included. Ensure that the white indicator arrow 

points to the appropriate setting. 

 

Fuses are: 

110 V- 1260mA anti- surge 

220/240V – 630mA anti- surge 
  



 

Page 28 

 

4. Probe Beam Optics 
 

A mirror- based relay optic is employed to image the output of the monochromator at the sample 

plane. This optic provides a magnification of ~1.2. In practice, it is an aperture which is imaged to 

provide a controlled probe spot on the sample. Therefore, an aperture is placed in the exit slit of the 

monochromator instead of the usual rectangular slit. 

 

One is limited here to the dimension of the aperture used (and therefore spot size), since, were the 

aperture larger than the entrance slit, it would define the system bandwidth, which may not be 

desirable. 

 

This eventuality has been catered for in the use of an extended aperture box attached to the exit slit, 

and by mounting the monochromator on a rail. 

 

In this manner, were for example a 5mm spot required, but the slit width used in the system be 

1.85mm (corresponding to 5nm with the 1200g/mm grating), then the 1.85mm slit would be placed 

in the exit port, and a 5mm aperture would be placed in the aperture box. 

 

The monochromator should be sent to a visible wavelength, using signal setup, and the position of the 

aperture in the aperture box adjusted such that the light output from the monochromator just overfills 

the aperture. 

 

The position of the monochromator should then be altered to achieve a focussed image of the 

aperture at the sample plane, and locked into place. 

  



 

Page 29 

 

5 Solar Simulator 
 

5.1 Overview 
 

The requirements of this system is for a ~1 cm2 uniform solar simulator output at the sample plane, 

tuneable from 0.1-1 sun output (1000 Wm-2) over the range 400-1100nm. 

 

 

Figure 5.1: Coupling from solar simulator 

 

The solar simulator comprises of 1 or 2 50W quartz halogen lamps, which are coupled by a rear 

reflector to a 6-branch glass fibre bundle, to achieve uniformity at the sample plane. This source 

should be operated at 4.00 A by the bias 610. 

 

The source is fitted with a solenoid-based shutter, controlled via a swing away mirror control in the 

monochromator to apply or not the bias source as required. Holders for 50mm square filters are 

provided to permit filtering the solar simulator should this be required. 

 

5.2 Mechanical 

 

The solar simulator is mounted to the wall of the PVE300, at which place is adapted the six branch 

fibre to the source. 

 

The six branches are connected to the sample optic by pushing through such that the ferrule is flush 

with the bottom of the holding plate, and are held by grub screw. 

 

5.3 Setting Irradiance Level 

 

The level of the bias can be adjusted by a bi-lateral variable slit, one turn of which equates to 0.5 mm. 

The levels can be measured and set, and the required micrometer setting recorded. 
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The position of the micrometer may be locked by the clockwise rotation of a collar at the base of the 

barrel; this should be loosened before proceeding to change. The level of bias can be measured 

directly as an irradiance measurement, or should one have access to a luxmeter, by measuring the 

illuminance in lux at the sample plane, one can use the following scaling factor to approximately 

determine the irradiance over the range 400-1100nm with no filter in place (37.6 lx ≈ 0.523 Wm-2) 
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6. DTR6 Integrating Sphere 
 

 

Figure 6.1: Geometry of DTR6 

 
6.1 Overview 
 

 

Figure 6.2: DTR6 installed in PVE300 

 

The DTR6, situated on an optical rail to the top of the PVE300 system may be used by relaying the 

probe beam, via the moveable 45° mirror to the horizontal plane. 
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Figure 6.3: Relay mirror reflecting light toward DTR6 

 

Used in one of two configurations, the DTR6 may be used for the measurement of 

transmittance or reflectance. 

 
6.2 Integrating Sphere Theory 

 

The integrating sphere is coated with Barium Sulphate, a highly diffusely reflecting material. 

 

It is so called, since light impinging on the walls of the sphere is reflected in all directions such that the 

light is “averaged” over the surface of the sphere walls; placing a detector in a first consideration, 

should read the same result independent of position. 

 

In practice this is not strictly the case since there shall exist entrance and exit ports in the sphere walls, 

and baffle structures are employed to prevent light from the source reaching the detector without 

being reflected off the sphere walls. 

 

6.3 Measurement of reflectance 

 

6.3.1 Measurement of reflectance 

 

The measurement of sample reflectance is made with respect to a reference standard of reflectance. 

The sphere is positioned at such a position that the probe beam is focussed onto the plane of the 

reflectance sample port. It is important that this image under-fills this port.  
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6.3.2 SPIN/SPEX reflectance 

 

 

Figure 6.4: For measurement of reflectance sphere pushed against right hand stop 

 

The integrating sphere captures all light reflected from the sample being measured. Here, one can 

distinguish between specular and diffuse reflection. 

 

Specular reflection is that which occurs at the same angle of incidence, and can be suppressed by 

placing a light trap at the SPIN/SPEX port- this signal shall be attenuated and shall not contribute to 

the measurement of reflectance. 

 

This is termed SPEX or specular exclusive reflectance.  

 

   

Figures 6.5 & 6.6: Specular trap, and fitted to DTR6 

 

On the contrary, SPIN (specular inclusive) reflectance is measured by placing a reflective plug at the 

SPIN/SPEX port. 
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Figures 6.7 & 6.8: Specular “includer”, and fitted to DTR6 

 

Light is reflected back into the integrating sphere and therefore is included in the measurement. 

 

6.3.3 Sample Port 

 

Slide clips may be attached to the sample port to hold samples in place. 

 

 

Figures 6.9: Sample port 

 

Where the sample to be measured is smaller than the port size, port reducers are provided, which 

screw to the sample port side. It is important to ensure that the probe beam size is selected such that 

the beam be smaller than the port at all times. 
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Figures 6.10: Set of port reducers 

 

 

Figures 6.11: Sample port reduced 

 

To aid visualisation of what is being measured at the sample port, is provided a viewer which attached 

to the specular port. 

 

 

Figures 6.12: Sample port viewer 
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Figures 6.13: Sample port viewer installed 

 

6.3.4 Reference Standard 

 

A PTFE-based reference reflectance standard is provided to calibrate the system against a presumed 

reference level of 100%. 

 

 

Figures 6.14: Reference standard in place 

 

6.3.5 Detector 

 

Light is detected by mounting the silicon-InGaAs sandwich detector at the detector port (lower). The 

output of this detector is coupled via the 498 amplifier to the lock-in amplifier. 
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6.4 Measurement of transmittance 
 

 

Figure 6.15: For measurement of reflectance 

 

 

Figure 6.16: Reflectance port cover sphere pushed against right hand stop 

 

The measurement of sample transmittance is made with respect to a system measurement with no 

sample in place. With a sample in place, any light that is transmitted may be diffused off the optical 

path. The integrating sphere collects all light transmitted through the 2π steradians behind the device. 

For this measurement, it is necessary to cover the reflectance sample port with the above cover.  
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7. X-Y Translatable Temperature Controlled Vacuum Mount 
 

7.1 Overview 
 

Measurements of spectral response being a function of sample temperature, the vacuum controlled 

temperature mount ensures stable sample temperature, even under operation of the one sun bias 

source.  

 

The temperature controlled vacuum mount is in turn mounted on an X-Y stage to allow measurement 

across the area of the sample under test. 

 

7.2 Temperature Controlled Vacuum Mount 

 

The temperature controlled vacuum holder has been designed to accommodate samples of a number 

of sizes, having a water cooled Peltier heat pump system to maintain sample temperature at the 

desired 20°C. 

 

There are three pipe connections to the mount, vacuum, water in and water out. A further electrical 

connection is provided for a temperature sensor embedded in the mount. 

 

Two probes are provided for electrical connection to the sample, one for p-up devices, and one to 

provide a ground, having a shorting termination at its’ BNC connector. 

 

An earthing point is provided to the side of the mount, and an earth strap provided. This latter can 

therefore connect either the mount to a p-up probe, or interconnect the two probes. 

 

 

Figure 7.1: Vacuum mount with probe 

 

The probes are mounted on magnetic base stands, and have a thumb screw adjustable mechanism for 

fine motion of the height of the probe. The electrical connections to the current amplifier being via 

co-axial cable, all connections to the detection electronics emanate from one probe. 
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7.3 Vacuum Mount 

 

The vacuum sample holder is formed in a cross pattern to permit use with large and small samples. It 

may be found that when using small samples, optimal operation of the vacuum would be had by 

covering the unused holes. 

 

The vacuum is connected via the chamber interface plate to the vacuum port of the controller. When 

switched on the air pump makes significant noise. It is recommended to minimise the length of the 

intervening pipe to obtain best vacuum performance. 

 

7.4 Temperature Control 
 

The temperature control comprises a water re-circulation system and Peltier cooler to provide only a 

cooling effect, with the desired set temperature of 20°C. 

 

The water re-circulation system enters one side of the mount, exits the other, and along the depth of 

the mount there exists spurs, akin to the design of a radiator heater, to ensure even distribution of 

water. 

 

The water circulation can be used on its’ own if desired, the cooling does not operate if the circulation 

is not on. 

 

A switch permits the selection of viewing on the LCD the actual mount temperature or the set 

temperature, the black rotary switch being used to define the temperature. This, when pushed in, is 

locked in place. 

 

Once the mount is filled then it is only necessary to drain and refill when the water becomes 

contaminated, as seen via the filling chamber. 

 

7.4.1 Filling the Water Re-circulation Circuit 
 

The fill procedure is as follows: 

 

 Using funnel fill reservoir 

 Switch on pump for short time ensuring all pipes are connected 

 Using an iterative process, switch on pump, and gently rock the vacuum mount to expel all air 

 Ensure there is no air lock in the reservoir 

 Top up reservoir 

 When air is expelled from the system the pump runs more quietly 

 Stop reservoir 

 Ensure the pump is not run for any significant duration without water. 
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Figure 7.2: PVE300 vacuum mount on X-Y stage 
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8. PVE300 Chamber 
 
The sample chamber is provided, with a door, to provide a means to perform measurement excluding 

all ambient light. The sample chamber has to the front right side a panel for making electrical 

connections to the inside of the box. At the rear right side of the chamber is provided a panel though 

which the connections to the temperature controlled vacuum mount are made. 

 

To the upper of the chamber, an optical rail is situated for use with the integrating sphere based 

accessories to measure reflectance and transmittance. A translatable 45° mirror permits relaying the 

probe either to the vacuum mount for the measurement of EQE or the DT6 six for measurement of 

transmission and reflectance. 

 

 

Figure 8.1: Relay mirror out of beam (EQE) 
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9. Detectors and Detection Electronics 
 

9.1 Overview 
 

The PVE300 has two modes of operation- with a DC probe or with an AC optical probe (10Hz-2kHz), 

often used in conjunction with a DC bias source. The conditions of measurement of spectral response 

and EQE, and signal recovery depends upon the material system under consideration, as discussed in 

§11.  

 

The measurement of reflectance and transmittance may be performed in either mode, yet AC is the 

default. An arrestable optical chopper is located in the dual light source to modulate the probe on a 

known carrier wave for AC operation; arrested DC operation obtains. 

 

9.2 System Detectors 

 

This system comprises three detectors. 

 

A calibrated 10x10mm silicon detector, and a calibrated 5mm diameter Germanium, both with 

calibration traceable to national standards, are used to calibrate the PVE300 for the measurement of 

spectral responsivity, by effectively determining the power in the probe beam as a function of 

wavelength. 

 

These device should not be used with the bias source, because of issues of linearity. 

 

 An un-calibrated silicon-InGaAs sandwich detector is mounted to the DTR6 in the measurement of 

reflectance and transmittance over the range 300-1700nm. 

 

9.3 Detection Electronics 

 

9.3.1 Components 

 

The detection electronics are housed in the 417 unit, to which is connected the controlling USB bus. 

The various components are as follows: 

 

Electronics 

Module 

Function 

417 Electronics modules bin, power supply and 

display 

474 Low noise pre-amplifier 

498 AC pre-amplifier/DC amplifier and ADC 

496 Phase insensitive lock-in amplifier and  ADC 

218M Chopper control 

Table 9.1: Installed modules 
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9.3.2 417 Bin 

 

 

Figure 9.1: 417 control panel 

 

The 417 bin provides power to and houses Bentham detection electronic modules. 

 

The display section of the 417 can be used to display the analogue output of certain installed modules. 

 

A rotary switch permits selection of displayed channel. 

 

Switch 

Position 

Function Displayed 

 

A Output of 496 (0-10V) 

Table 9.2: Live display channels 

 

A BNC socket provides output of the function selected by the rotary switch. 

 

Whilst the mains voltage is set up at Bentham according to where the device is sent, it is of good 

practice to verify before powering up the 417. 

 

A toggle selector should be found underneath the mains connector to the rear of the 417. Please 

ensure that the voltage of the country in which the device is to be used is displayed. 

 

At Bentham, the appropriate fuse (plus a supplement) is fitted. Should the voltage setting be wrong, 

please ensure that the correct fuse is installed.  

 

The fuse rating is as follows: 
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220/240V  630mA anti-surge 

110V 1260mA anti-surge 

 Table 9.3: Fuses used for different local voltages 

 

9.3.3 474 Transformer/Ultra-Low Noise Pre-amplifier 

 

 

Figure 9.3: 474 Transformer and Transformer Pre-amplifier 

 

The cell is operated in either short circuit or under voltage bias to perform measurements. From there 

the 474 transamplifier decouples the AC optical probe generated photocurrent from that generated 

by the DC bias source, whilst the amplifier provides a fixed 1000x gain to boost the signal coupled from 

the transformer. The input from the transformer and output to the lock-in amplifier are labelled. 

 

9.3.4 498 AC Current Preamplifier/DC Nanoammeter and ADC 

 

 

Figure 9.4: 498 Current Pre-Amplifier and Integrating ADC 



 

Page 45 

 

 

The cell should be operated in short circuit. This programmable AC current pre-amplifier/DC 

nanoammeter and ADC includes six decades of gain and a 14-bit ADC. This is, in normal use controlled 

by BenWin+.  

 

It is possible to use locally should the need arise. To use locally, push the RTL button. This permits 

using the two buttons to the right of the gain range LEDs to change current gain range and the lower 

button to change between inputs. 

 

This amplifier is for use when no or little DC bias is employed, and saturates at 100mA. Overload of 

range in use is indicated by red LED. The output of the 498 is 0-10V. 

 

In the DC mode, the 498 operates stand-alone, in the AC mode, the output of the current amplifier 

should be connected to input 1 of the 496 module. For details of the ADC, please see §9.3.6 

 

9.3.5 496 DSP Lock-in amplifier and ADC 

 

 

Figure 9.5: 496 DSP Lock-in Amplifier and ADC 

 

The 496 combines a lock-in amplifier with an analogue to digital converter and is used to recover an 

optically chopped signal between 10-2000 Hz. Inputs to the 496 are either directly from a voltage 

generating detector or through the 474 or 498 amplifier. 

 

Reference input, the output signal from the chopper control module is also required for use. To use 

locally, push the RTL button. Each gain range of the lock-in amplifier outputs 0-10V. 

 

The 496 lock-in amplifier is a key component of the system when operating in AC conditions where 

the optical signal to be measured may be confounded with a background optical signal, whether from 
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ambient lighting, or in the infrared, heat (or infrared radiation) emitted by instrumentation and the 

background.  

 

To discriminate the two contributions, the optical signal to be measured is modulated on a known 

carrier wave by an optical chopper, the relative phase difference between these two waveforms must 

be taken account of. In the 496, the input and reference are digitised prior to determination of the 

components in two orthogonal states in order to take the vector sum of the two. Phasing intervention 

as is custom with traditional lock-in amplifier-based systems, is therefore not required. 

 

For details of the ADC, please see §9.3.6 

 

9.3.6 ADC 

 

The ADCs uses a continuously running voltage to frequency converter to produce a pulse train whose 

frequency is proportional to the instantaneous input voltage. The pulses are accumulated in a counter.  

 

At fixed intervals, 100ms, the contents of the counter is transferred to an output buffer and the 

counter reset to zero. The total number of pulses accumulated by the counter in any counting period 

represents the true average of the signal during that counting period. If the accumulated pulses from 

a number of counting periods are added and normalised then a true average over a longer period is 

obtained. 

 

The ADC has two other special features which enhance its usefulness in light measurements systems. 

Firstly, the input to the ADC is offset giving the unit a small negative range. This ensures that negative 

going noise peaks, occurring in near zero signals, are correctly averaged while retaining most of the 

available resolution for positive going signals. 

 

Secondly, the ADC provides information to the computer indicating that a transient overload has 

occurred at some point during the conversion period. This information is essential if accurate 

measurements are to be made on pulsed light sources such as CRT monitors. 

 

The ADC provides 2000 counts per volt and has a maximum of 20000 counts. 

 

Due to the quantum nature of light and the way in which optical detectors work, signals in light 

measurement systems are always accompanied by electrical noise.  The limit of low light level 

detection is often imposed by the ability of the measuring system to distinguish between the signal to 

be measured and the associated electrical noise.  

 

In most cases, where the noise is truly random, the signal to noise ratio can be improved by averaging. 

For a signal accompanied by random noise the signal to noise ratio will increase in proportion to T  

where T is the averaging period. 

 

With dc systems the maximum period which can be used for averaging is limited by so called dc drifts 

(i.e. low frequency noise. The noise power in fact increases continuously as zero Hz is approached). 
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The ADC therefore behaves as a digital averager with the averaging period programmable in 100ms 

increments. 

 

For DC systems the averaging period can be fixed for a particular experimental set-up or can be varied 

depending on the signal level to give a substantially constant signal to noise ratio for all signal levels.  

 

Software schemes have been used where the averaging period is determined by looking at the 

variance between successive readings or, more simply, by linking the averaging period to the 

sensitivity range of the amplifier so that averaging period increases as the sensitivity required 

increases. This last approach is very useful in solar UV measurements where in a typical spectral scan 

from 280nm to 400nm the signal level changes by 106. 

 

Similarly, measurements which have included a transient noise pulse such as that produced by 

Cherenkov events in the window of a photomultiplier, can be recognised and repeated if required. 

 

9.3.7 218 Arrestable Chopper controller 
 

The optical chopper is controlled by the 218 unit, with connection between the controller and the 

chopper by an amphenol socket connector. 

 

The dial shows the chopping frequency for a ten-slot chopper blade. This dial can be locked and 

unlocked by a small tab underneath the dial. The value should be scaled according to the blade fitted 

to a particular system. 

 

This system is provided with a twenty slot blade only. It follows that the dial shows double the actual 

frequency applied. The system is set to 295Hz on the dial, resulting in a chopping frequency of 590Hz, 

used for all applications. Ensure that a BNC takes the reference output to the reference input of the 

lock-in. 

 

An optical sensor on the chopper provides feedback to the controller to provide the reference signal. 

Ensure that the reference from the front of the controller goes to the lock-in amplifier reference input. 

 

In this system, the chopper is arrestable via an electromagnet. To stall the chopper for use in the DC 

regime simply power off the chopper using the on/off switch on the front panel of the 218M module. 
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Figure 9.2: On/Off switch to use or arrest the chopper 

 

Note that when returning to the AC mode, that the lock-in may take some time to re-find the 

reference. This can be speeded up by momentarily powering down the 417 electronics, closing 

BenWin+ and re-initialising. 
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10. BenWin+ 
 

10.1 Introduction to BenWin+ 
 

BenWin+ is a Windows software designed to control Bentham’s range of monochromators, detection 

electronics and accessories. 

 

On running the software, initiating an initialisation procedure establishes communication with the 

hardware.  

 

BenWin+ then reads a file of type *.cfg, (entitled system.cfg by default). This file describes the 

elements of hardware to be controlled and their USB address (PID and VID) 

 

By default a *.atr file of the same name as the *.cfg file used is looked for. This file describes the 

parameters of the instruments of the system. Groups of cfg, atr files and scan properties can be saved 

in a configuration to permit easy migration between setups. Configurations are saved in .xml files. 

 

Features include: 

 

 User initiated or time-delayed spectrum scanning (schedules) 

 Easy system calibration, irradiance, radiance, detector responsivity etc 

 Obtain spectrally integrated quantities (candelas etc) 

 Instantly obtain colorimetric data 

 Perform transmission, absorption and reflection measurements 

 Perform simple arithmetic functions 

 Add-on for control of translation stages, goniometers, data acquisition from other 

instruments etc 

 Direct export of measurement data to excel, with capability of running macros 

 The software can also be run in stand-alone mode to view measurement results at a later time 

 

The following sections will be divided into configuration, measurements, analysis and menu reference. 

 

10.2 System configuration 
 

The drivers for both the TMc300 and the 417 are automatically recognised by windows. The process 

to add new hardware should be followed once for each instrument before using BenWin+. 

 

 Connect the USB to the monochromator and power on 

 Wait until windows finds new hardware 

 Allow windows to search for the required drivers automatically 

 Perform the same process for the 417 
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10.2.1 Installing BenWin+ 

 

 Insert BenWin+ CD into computer, and double–click on setup. This takes you through the 

setup process, select complete installation 

 A Bentham\BenWin+ folder is created in C:\Users\Public\Documents 

 A shortcut to BenWin+.exe shall be found also on the desktop 

 This system is based on the use of configurations, it is necessary in the first instance to setup 

BenWin+ into configuration mode 

 Run BenWin+ 

 Go to Tools  Options and select “prompt for configuration on start up”, hit apply 

 Close window and close BenWin+ 

 Go to c:\program files\Bentham\BenWin+ 

 Delete the created file configuration.xml 

 

Finally, ensure that in C:\Users\Public\Documents\Bentham\BenWin+\Calibration, the certificate files 

have been installed. These are the calibration files of the reference detectors. Should they not have 

installed, they can be directly copied from the CD accompanying the calibration certificates. 

 

10.2.2 Getting the software started 

 

 Run BenWin+ to be presented with the following window:  

 

 

Figure 10.1: Configurations menu 

 

 Double click on the required configuration to use 

 If the window above does not appear go to Tools → Configurations… and select the 

configuration to use 
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10.3 Instrument attributes 
 

To view the instruments in the system go to Instruments in the toolbar. This lists the system 

components, giving access to their properties. 

 

Note that these properties are saved in the configuration file. On closing BenWin+, by default any 

changes made herein are saved. This default can be removed by going to Tools → Options and de-

selecting “save instrument attributes to file on exiting the application”. Hit apply. 

 

Should any problems be encountered, if in doubt reload the configuration files from the installation 

CD to re-establish the initial conditions. 

 

10.3.1 TMc300 Monochromator 

 

Selecting this page gives access to the parameters of the monochromator. Selecting Advanced>> gives 

access to the grating properties. For grating values of this system please see the calibration certificate 

 

 

Figure 10.2: Monochromator settings 

 

The pull down arrow permits toggling between turrets and gratings. The zord and alpha 

measurements are obtained from the calibration certificate. 
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10.3: Turret and grating drop down  menu 

 

Monochromator settle delay of 100ms should be sufficient.  

 

10.3.2 Filter Wheel 

 

The filter wheel has six positions. The filters in place are described in section 2.3, and are specified 

here by their wavelength of insertion.  

 

 

Figure 10.4: Filter wheel window 

 

The settle delay is the pause taken by the system following each action. 1000ms is sufficient. 

 

10.3.3 Swing Away Mirror (SAM) 

 

This page is accessed via a link in the monochromator page. The states of each SAM is as follows: 

 

Deflect: Select Xenon source 

No-deflect: Select QH source 
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10.5: Swing away mirror menu 

 

Define states by the wavelength of insertion (inclusive), and the SAM state. In advanced>> can be 

named the two SAM states for easier setting up. 

 

 

10.6: SAM states and naming conventions used 

 

Settle delay of 1000ms is sufficient.  

 

10.3.4 498 AC Pre-amplifier and DC Nanoammeter  

 

This applies to the AC high-sensitivity, DC mode and DC chopped configurations. The properties page 

of the AC pre-amplifier and DC nanoammmeter are the same. The settings window is shown below.  
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Figure 10.7: 498 amplifier menu 

 

All ranges are used, it is recommended to use range 1 as the start range. Setup 2 is not required in this 

application. 

 

Settle delay of 1000ms is sufficient. 

 

10.3.5 498 Analogue to Digital Converter (ADC) 

 

The 498 ADC integrates over 100ms periods. One can choose how many of these periods shall be taken 

to determine the reading at each wavelength. 

 

 

Figure 10.8: 498 ADC menu when (l) a single value of samples is used and (r) when adaptive integration is used 

 

A good number to use for reasonable signal is 5 averages. 

 

One may also select adaptive integration which permits varying the number of averages taken as a 

function of the gain range of the current amplifier, fewer averages in the low gain ranges and more in 

the higher gain ranges to smooth out noise. 
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10.3.6 496 Lock-in amplifier and ADC 

 

The lock-in amplifier page permits definition and viewing of the gain, window function and integration 

time of the two inputs. 

 

 

Figure 10.9: 496 DSP Lock-in menu 

 

It is recommended to use 1/16 and 16384 as the minimum and maximum gains. Since this lock-in 

amplifier is completely autonomous users only need to select the input that they wish to be read, with 

no need to define the phase and offset of the signal. 

 

The ADC operates as described above in 10.3.5. It is recommended that and integration time of at 

least 450 ms be used.  

 

10.3.7 498 DC Lock-in 

 

 

Figure 10.10: 498 DC Lock-in Settings 

This window is only used in DC chopped mode and depicts the settings used in this mode. ADC reads 

is the number of readings taken for each point, while the number of cycles is the number of times the 
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chopper cycles before moving on to the next wavelength. Chopper settle time is the time interval 

between the chopper movement finishing and a reading being taken. 

 

10.3.8 Miscellaneous 

 

The miscellaneous page is as follows. The dark integration time, the time over which dark current is 

integrated is factory set to 5 seconds and should be sufficient. 

 

 

Figure 10.11: System attributes menu 

 

10.4 Measurements and utilities 
 

10.4.1 Introduction 

 

BenWin+ is a general purpose spectroradiometer software, wavelength scans being its habitual use. 

Other functions include setting the monochromator to a given wavelength, timed scans at a given 

wavelength, scans according to a schedule, system calibration, and relative measurements. 

 

Spectral scans involve the initial measurement of the system with respect to a reference. This 

reference may be a lamp of known output, a reflectance standard or a 100% “no-sample” 

measurement. 

 

By comparing the measured signal obtained as a function of wavelength with the reference, can one 

determine the nature of an unknown sample. 

 

The system therefore effectively measures the detector photocurrent under stimulation by the 

source, as a function of wavelength, which is therefore a convolution of the source output, the spectral 

response of the input optic, the monochromator (mirrors and diffraction grating) and of the detector. 

 

As shall be seen in the next section, an advanced menu gives access to change items such as zero 
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10.4.2 Hardware operation 

 

The initialisation procedure establishes communication with all hardware components, and moves the 

monochromator to a known reference point.  

 

For M300 and DM150 monochromators, the gratings are moved to a maximum positive limit the 

corresponding wavelength of which should be input to the software at installation. 

 

For TM300 and DTM300 monochromators, the procedure moves the monochromator moves the 

turret to a negative mechanical limit, the software being instructed via the system.atr file the number 

of steps from this point is the zero-order position of a given grating. 

 

Now, in most systems there exists a filter wheel, in position six of which is a blank to shut off the input 

to the monochromator. This is used in the determination of the detector dark current, and to protect 

the detector from continual exposure.  

 

When scans are launched, it is important to perform the zero-calibration procedure. 

 

This procedure shuts the input to the monochromator. In the first instance sets the current amplifier 

to maximum gain range (ranging to a lower gain range if this range is in overload). When stable, the 

output of the ADC is read.  

 

This constitutes the detector dark current. The current amplifier is then set to its’ minimum gain range, 

and the ADC read. The signal measured does not come from the darkened detector at this point, what 

is registered is the offset of the detection electronics. The 20,000 count ADC has ~400 counts reserved 

for negative-going noise signals. With no stimulation therefore, the system should read ~400 counts. 

It is important to realise the importance of ensuring this offset is taking into account.  

 

Consider for example a large signal in a higher gain range, say 18000 counts, ranging to a lower gain 

range, where the counts may be 1800.  

 

The relative impact of not subtracting the 400 count offset leads to discontinuities in the spectrum 

should zero-calibration not be taken into account. 

 

Should zero-calibration be not selected, provided that the system has performed at a previous point 

this routine, the same values shall be carried through at all times. 

 

This is not recommended, particularly in the case of for example photomultipliers, whose response is 

very temperature and condition dependant. 

 

In the scan parameters page, it is recommended that the zero-calibration routine be applied, that the 

amplifier be permitted to auto-range, that the shutter is closed post-scan, and that the 

monochromator is returned to the start wavelength for the next measurement.  
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Furthermore, where add-on modules are employed, ensure that appropriate pre- or post-scan module 

fields are selected. 

 

10.4.3 Scan setup 

 

Spectral scans are initiated by going to the Scan menu and selecting Scan setup to reveal the following: 

 

 

10.12: Scan setup menu 

 

 Enter the wavelength range required 

 Select bandwidth required 

 Select number of scans required 

 Click on advanced>> for further features:  

 

 

Figure 10.13: Advanced setting within the scan setup menu 

 

 Ensure that zero calibration is selected. This determines ADC offset and dark current at 

beginning of scan 

 Ensure that autorange is selected, permitting the amplifier, to change gain range where 

appropriate 
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 It is of good practice to have close shutter and return to start wavelength selected. 

 Should it be desired that all spectra are saved, select auto save and define file name prefix 

and number suffix 

 Click on new scan for measurement 

 

When performing initial measurements of a calibration standard, ensure that data correction is not 

selected- this uses the calibration mode of the software not required at present, the y-axis of the scan 

window once launched should read Signal (nA). Having performed measurements of the calibration 

standard, and having implemented a correction (see below), ensure that data correction is selected 

to determine the corrected output of unknown sources. 

 

The following window shall be seen in the foreground, detailing the progress of the scan, whilst a 

spectral plot will appear in the background.  

 

The shape of the uncorrected scan will vary depending upon source, gratings, etc, but it is normal that 

there be relatively sharp features, with loss of response towards the ends of the spectrum.  

 

Furthermore, a slight discontinuity may be seen at the insertion of order sorting filters. All of these 

features “calibrate out”.  

 

 

Figure 10.14: Graph and scan window during measurement 

 

At the end of a scan, you shall be presented with the following screen. At this point one may, if desired 

choose to export the spectrum to excel (either for viewing, to perform calculations or to run macro 

which may be specified), or one may simply close this window. Please see §10.5-10.8. If autosave 

should not be selected, ensure that the current spectrum is saved. 
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10.15: Post scan menu 

 

10.4.4 System Calibration 

 

System calibration refers to the calibration of sources or detectors against standards. For 

measurements against reflectance etc standards please see section §10.4.6. 

 

The measurement of any unknown source with a spectroradiometer, or the response of an unknown 

detector means nothing without comparison to a standard such as those obtained or compared with 

scales as defined for example by the National Physical Laboratory. 

 

Such measurements require a first scan of a standard prior to measurement of the unknown device. 

An example of this can be seen in the following figure, the irradiance of a lamp being required.  

 

The upper scan is the throughput of the monochromator system when viewing the unknown lamp, 

having actual irradiance displayed in the lower spectrum. 

 

 

Figure 10.16: Raw scan and calibrated scan data 
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The ratio of the calibration data showing the true device spectrum, to the system measurement, yields 

a wavelength dependant system correction factor. All future measurements ought to be multiplied by 

this correction curve to yield a true reflection of the source unknown device spectrum. 

 

This rationale applies for the determination of detector responsivity. 

 

It is also of importance to reflect the quantity of the calibration measurement, whether it be 

irradiance, radiance etc. This correction, and subsequent presentation of data in correct quantities 

and units, is implemented in BenWin+ via the data correction page.  

 

Firstly to apply data correction two files are required: 

 

1. A  *.bcf Bentham certificate file of the source calibrated results with measured quantities and 

units 

2. A *.ben, system file, measurement of the unknown device in the same step  

 

The procedure is as follows: 

 

 Perform scan over desired spectral range of standard source 

 Ensure that data correction is not selected and that the units of the measurement are in nA 

 Save scan 

 Go to Scan → Data Correction page 

 

 

Figure 10.17: Data correction menu 

 

 Using … button select appropriate *.bcf file for device 

 Select just-saved scan as system file 

 Hit Calculate calibration data 

 Save to file 

 When prompted do you wish to apply data correction click YES 

 Return to scan setup, and then scan as normal 
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Note that the y-axis should reflect the correct quantity to be measured. Ensure that the next time that 

a comparison to standard be performed, that data correction is NOT selected. 

 

One may view the *.bcf file by selecting open/all files and find the .bcf files in the BenWin+ calibration 

folder. 

 

If you have no .bcf file, you can create one by the following process. 

 

 Prepare your calibration standard data as a two column ASCII file with no header nor footer, 

wavelength in the left column, measurement in the right 

 Save this file 

 Go to BenWin+ → File → Import 

 

 

Figure 10.18: Import data menu. This can be used to create certificate files 

 

 Select units and quantity of measure, select certificate file and import 

 Chose the file of your data and save in the BenWin+ calibration folder 

 

10.4.5 Reference Measurements 

 

The reference setup can be found in the scan menu. This permits the direct measurement of 

transmission, reflectance and absorbance of samples. 

 

No calibration correction is applied here. Of interest is the comparison of the raw measured signal 

with either no sample (for transmission and absorbance) or a standard (for reflectance) in place, and 

then with the sample under test in place. 

 

In the case of reflectance, the standard used may be presumed to have 100% reflectivity, or one can 

specify a calibration file with the true reflectance of the standard. This file should be in absolute units. 

 

The measurement procedure follows: 
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 Go to scan/scan setup 

 Ensure in advanced>> that data correction is NOT selected 

 Perform scan over required spectral range 

 Save file 

 Go to scan/reference setup 

 

 

Figure 10.19: Reference setup menu 

 

 Select required measurement type and unit 

 Select reference to apply , constant (inputting reference level) or spectrum 

 Use “…” to load just saved reference spectrum 

 In the case of reflectance, should a calibration file be held for the standard, load this file using 

the … 

 Select use reference calculation 

 Return to scan setup 

 Perform scans in the usual manner 

 To use another reference file, use the … button to select other file 

 To perform a new reference level, ensure that “use reference calculation” is switched off 

 To switch of calibration correction, hit C button to remove file 

 

10.4.6 Stationary Scans 

 

It is possible to perform time-based scans at a fixed wavelength. This is particularly useful when for 

example monitoring a lamp to determine warm- up stabilisation period, or for example to measure 

the transmission of a photochromic material during or after activation. 

 

Go to Scan → Stationary Scan setup to reveal the following:  
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Figure 10.20: Stationary scan menu 

 

Define scan length, scan interval and monitor wavelength. It is sometimes useful to perform a spectral 

measurement of an unknown source beforehand to determine the spectral output, and therefore to 

determine the wavelength of monitoring. 

 

In advanced, one can select whether data correction be applied or not. Ensure that auto ranging and 

zero calibration are selected for correct measurement. The scan interval should not be less than the 

ADC read interval. 

 

10.4.7 Signal Setup 

 

The signal setup page permits moving the monochromator to a given wavelength, of use for certain 

measurements, and also useful when aligning optics. 

 

 

Figure 10.21: Signal setup menu 

 

Input the desired wavelength in Target Wavelength and hit Go to wavelength. Note that one might 

monitor the zero order contribution by typing 0 for the wavelength.  
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Note that here there may be a large signal which may be of consequence with the detector in use 

(particularly if a bi-alkali photomultiplier is used, for which high signal stimulation might cause 

hysteresis effects). 

 

Once at the given wavelength, the filter wheel opens the shutter. Selecting the monitor signal box 

ranges the amplifiers to determine the current signal. 

 

One might also define a step size, and manually scan over a spectral range by hitting the scan up and 

scan down buttons. Note that the monochromator control is designed such that a given wavelength 

be reached in one direction only, that of increasing wavelength.  

 

This is to ensure the best wavelength calibration. When scanning down the wavelength scale, the 

system goes beyond the wavelength selected to approach in the increasing direction. 

 

10.4.8 Signal monitor 

 

The signal monitor opens the shutter and monitors the signal at the current wavelength. A graphic 

with auto-ranging y-axis shows the current signal and is update as fast as possible. 

 

10.4.9 Set file information 

 

One can associate information with each scan by going to Scan → File Information. Here one can 

define a number of fields hitting the + button, double clicking on the field entry on each line to edit 

to, for example, Operator, Lamp type etc. One can pre-define the file information to prevent re-typing 

information common to each measurement. Highlight and hit the – button to delete a field. 

 

 

Figure 10.22: File information window 

 

With Use file information selected, on starting a new scan a window prompts for the entry of the 

required file information values. File information is saved with scan data. 
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10.4.10 Add-ons 

 

In order to increase the flexibility of a given system, add-on modules permit the interfacing of for 

example the control of further instruments, as part of BenWin+, or specific data analysis post-scan. 

 

 

Figure 10.23: Add-on modules menu 

 

Add-on module dlls should be placed in the BenWin+/Add-ons folder. They can be implemented via 

the add-on modules page, and selected as either pre- or post- (or both) add-on modules. Pre-scan 

modules are used in instances where control or measurement during scans is required, post-scan 

modules when calculations are involved. 

 

10.4.11 Auxiliary measurements 

 

It is possible to collect data from a source other than the principal monochromator detector. This 

source might be obtained via either a Bentham two input current amplifier or relay unit, or via an add-

on. 

 

Should a calibration factor be associated with this auxiliary measurement, this may be defined via this 

page.  
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Figure 10.24:  Auxiliary measurement menu 

 

 Define whether standard, auxiliary or both measurements are to be performed 

 Define whether a calibrated detector or add-on module is employed 

 Data are acquired at each point in the ranged defined as a scan 

 

Should a calibrated detector be employed, it is of question to define the source, input, conversion 

factor, offset and measurement type. Covering the detector, one can hit the zero calibrate button to 

take the dark current of the source. 

 

The measurement type can be either: 

 

 Radiance – mW sr-1 m-2 nm-1 

 Radiant Intensity – mW sr-1 nm-1 

 Irradiance – mW m-2 nm-1 

 Radiant Flux – mW nm-1, 

 Detector response – A W-1 nm-1 

 

10.4.12 Post-scan 

 

A scan having finished, one is presented with the following window: 
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10.25: Post scan menu 

 

If autosave was not selected, save the file now. In the following sections are given information on the 

three BenWin+ data views, and the direct exportation of results to Excel. 

 

10.5 Spectrum View 
 

10.5.1 Introduction 

 

This default view presents a view of the spectral distribution of the source, as a function of wavelength 

(or as a function of time in the case of time-based scans). 

 

 

Figure 10.26: Xenon spectrum  

 

Having performed a scan, within this view the data may be analysed via functions in the analysis menu, 

or using a right mouse key short cut button.  

 

These functions follow, starting with the analysis menu. 
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10.5.2 Set spectrum names 

 

In Analysis → Set spectrum names. One may either autoset file names or change each entry manually. 

 

 

Figure 10.27: Set spectra names menu 

 

10.5.3 Overlay spectra 

 

One can overlay different spectra by going to Analysis → Overlay spectra. Having more than one 

spectrum window open, it is possible to superimpose selected scans into a given window. 

 

Those available spectra are found in the left hand window, may be highlighted and the → arrow used 

to place the spectrum in the list to superimpose. Hit OK to apply. 

 

10.5.4 Delete spectra 

 

One may delete spectra from a multiple-spectrum window by going to Analysis → Delete spectra. 

Check off spectra for deletion, hit OK. 

 

10.5.5 Interpolate 

 

One might apply a cubic spline to interpolate or extrapolate given spectral data. 

 

 Go to analysis →interpolate 

 Modifying the start or stop wavelengths truncates the scan 

 Enter the desired step size. 
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Figure 10.28: Interpolation window 

10.5.6 Cut 

 

 Go to Analysis → Cut 

 Check off from the list the spectra desired to truncate  

 Define the lower and upper limits, then hit OK 

 

 

Figure 10.29: Cut spectra window 

 

10.5.7 Concatenate 

 

One can concatenate two spectra, to obtain a single spectrum. 
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Figure 10.30: Two spectra to be concatenated 

 

The spectra need not be continuous, but where a sub-set of the values are not exclusive, the latter 

sub-set is not modified, the remainder of the set being concatenated. 

 

10.5.8 Invert 

 

Select to obtain a mirror image in the plane of the x-axis of a given spectrum. 

 

10.5.9 Normalise 

 

 

10.31: Normalise spectra window 

 

One may normalise selected spectra to: 

 

1. A single value, defined as the maximum, set usually to unity 

2. A range, define maximum and minimum limits 

3. A selected wavelength, define the wavelength and the maximum wavelength 
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10.5.10 Spectral arithmetic 

 

Having one or more scan windows open, one can perform simple arithmetic, either multiplying a 

spectrum by a constant or another spectrum. 

 

 

Figure 10.32: Spectral arithmetic window 

 

• With the window of the first spectrum active, go to Analysis → Spectral Arithmetic 

• Select the spectrum (or spectra) for Operand A, the operation required, and for Operand B 

select either a constant (defined lower) or another spectrum 

• Select Replace or add new spectra, then OK 

 

10.5.11 Spectral average 

 

Having performed a number of scans of a given source, one can perform a spectral average, 

determining also the standard deviation and two spectra based on the minimum and maximum values 

at each point. These results are labelled accordingly, and are presented on the active spectrum 

window. 

 
10.5.12 Quantum efficiency 

 

In the case of detector responsivity (A W-1 nm-1) the responsivity results may be converted to quantum 

efficiency, defined as the ratio of electrons extracted for the number of incident photons. This process 

is non-reversible, ensure that the original detector responsivity has been previously saved. 
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Figure 10.33: (l) Detector responsivity and (r) Quantum Efficiency 

 

10.5.13 Peak picker 

 

Having performed for example a scan of a line source, the peak picker function may be used to 

determine the wavelength position of these peaks. 

 

Typically using the auto-settings function should find the peaks present. The results are noted on the 

graph, a measurements window to the right of the spectrum window also displaying the results. 

 

 

Figure 10.34: Xenon spectra with peaks denoted by the peak picker 

 

Should certain peaks not be found using the auto settings, then the set thresholds window can be 

accessed. 
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10.35: Peak Picker window 

 

The functions are as follows. 

 

Using the auto-settings function overwrites all changes to thresholds. 

 

Smoothing: Reduces errors due to a noisy spectrum. Broad peaks should be smoothed with a larger 

number of sample, the converse for narrow peaks. 

 

Threshold Y Level: Enables the rejection of peaks whose height above a local baseline is below that 

value. 

 

Sensitivity: The Sensitivity threshold allows the user reject peaks whose absolute height is less than a 

set value.  

 

Minimum Gradient: The Minimum Gradient (Value >0) threshold is used to define the peak edges. 

Points at which the absolute gradient are greater than the Minimum Gradient are considered to be 

peaks. 

 

Minimum Area: Peaks with an area less than the Minimum Area are rejected. This discounts delta-

function peaks such as caused by cosmic events. 

 

10.5.14 Spectral Integrals 

 

Spectral integrals and action spectra can be applied in the Analysis → Set spectral integral. 
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Figure 10.36: Spectral integration window 

 

+ add integrals, define name, spectral range, and action spectra. Action spectra are two-column ASCII 

files (wavelength, value) saved as *.ACTION in BenWin+ folder. 

 

One may define a group of integrals and save for use later. 

 

For the first time go to Analysis → Calculate spectral integrals to view results. 

 

Thereafter, BenWin+ will present results automatically. The data are also saved in the *.ben file. 

 

10.5.15 View menu 

 

Through the view menu, one can toggle to further views as described in the following sections, as well 

as looking at spectral data and viewing or adding markers and cursors to determine the positions of 

features. 

 

Markers may be automatically positioned using the peak pickers function or via cursors. 

 

One can view the numerical data by selecting View → Spectral Data. Re-select to remove the 

measurement data. 

 

One can place up to two cursors on the canvas of the spectrum to manually probe the measurement 

results. 

 

The cursors are accessed via View → Cursors. 
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Figure 10.37: Cursor position window 

 

Controls of the two cursors are on either side of the window.  

 

Hit display to obtain the cursor which may be dragged in place with the mouse. The wavelength and 

signal of the cursor position is displayed. 

 

One may choose to add a marker at that position. When two cursors are active, the lower section of 

the cursor window shows the difference and integration between the cursors. 

 

When multiple spectra are present in a given window, the keyboard up or down arrows selects the 

curve under consideration. 

 

Hit clear to remove the cursor from the graphical view. 

 

Going to View → Marker List provides the user with a list of extant markers in a window. 

 

10.5.16 Further features 

  

Further menu features, including short-cuts to some of the above are obtained from a menu activated 

with right mouse click over a spectrum window. 

 

These items are as follows: 
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Figure 10.38: Graph with spectrum window shortcuts 

 

Plot settings: Define the aesthetic aspects of the graph, line colours, labels etc. 

 

Show All: A zoom is provided by pushing left mouse button, holding down the button one can create 

a zoom box whilst moving the mouse to view a particular region of the spectrum. Show all returns to 

a view of all data. 

 

Peak Zoom: Automatic finding and viewing of peaks 

 

Set spectrum names: See §10.5.2 

 

Overlay spectra: See §10.5.3 

 

Linear/Logarithmic axis: Set y-axis as linear or logarithmic axis 

 

Wavelength colours: Superimposes wavelength colours to a scan over the visible region. 

 

 

Figure 10.39: Spectrum with the wavelength colours overlaid 

 

View CIE/spectrograph: Toggle between views 
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View spectral data/marker list/measurements: Presents to right of spectrum window spectrum 

values, markers and calculated measurement values (spectral integrals) 

 

10.6 Export to Excel 

 

It is possible to export scan results to Excel, either at the end of a scan or via the scan menu. Via the 

post-scan page in Advanced >>, one can edit the Excel export settings. 

 

 

Figure 10.46: Excel export settings 

 

Having performed multiple scans in one window, the Export Multiple spectra to multiple sheets button 

becomes active. This permits the choice of exporting each spectrum to an individual worksheet, or 

placing all in one worksheet.  

 

One may choose whether or not to plot the spectrum on exporting to Excel. Should a macro be 

required, select “Run macro” to run pre-defined macro (see appendix 4 for information on writing 

macros). Define the macro file using the “…” button to select, and define the name of the required 

macro. One may choose to autosave in Excel, in which case a filename is required. Else, one can export 

via File → Export → Export to Excel 

 

10.7 Use of BenWin+ on Desk Computers 
 

It is possible to install BenWin+ on a desktop computer to view measurement results extra-laboratory. 

 

• Load BenWin+ software CD into computer.  

• Double click on the set-up launcher icon, which shall take you through the set-up process. 

• You may now run BenWin+ for use to load saved spectra etc. 

• Initialising will not however work 

 

10.8 Menu reference 
 

The following is a reference of those BenWin+ specific menu items. 
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10.8.1 File 

 

An expanded menu is available when a spectrum opened. 

 

Import ASCII data: Import ASCII two-column ASCII file wavelength in left column, values in right, for 

preparation as BenWin+ spectrum, certificate or calibration file. 

 

 

 

 

10.47: Import ASCII Data window 

 

Using pull down menus, define measurement type, units and file type. 

 

File types are:  

 

1. *.ben: BenWin+ spectrum file 

2. *.bcf: BenWin+ certificate file. When applying data correction, the certificate file must be in 

this format 

 

Import Colorimetry data: Import data from ASCII file. 

  

Export to ASCII: Export spectral results to two-column ASCII file (*.dat) 

 

BenWin+1.0 file: BenWin+ spectrum files contains not only spectral file information, but colorimetry, 

dark current, integral values etc. Now, BenWin+ 2.0 saves files in binary format, version 1.0 in ASCII 

format. Export to version 1.0 file to extract required values in ASCII format. 

 

Export to Excel: Export spectral results to Excel 

 

Graphics File: Export graph in a number of image formats. Having chosen file name and format, the 

user is then presented with a window to define resolution.  



 

Page 80 

 

 

Measurements to ASCII: Where spectral integrals of an add-on processes further the spectral data, 

this permits exporting these values to ASCII 

 

Copy: Copy spectral values or measurements (integrals or add-on values) to paste as text. 

 

Properties: Provides details of spectral measurement, including spectral range, correction factors, file 

information and summary of scan events. 

 

10.8.2 Scan 

 

 Scan setup: See §10.4.3 

 Signal setup: See §10.4.7 

 Stationary scan setup: See §10.4.6 

 Signal monitor: See §10.4.8 

 Set averaging: Short-cut to Instruments → ADC page. See §10.3.5/10.3.6 

 Scan summary: Provides a summary of actions performed by the system over the defined 

spectral range in scan setup page 

 Data correction: See §10.4.4 

 Reference setup: See §10.4.5 

 Add-on modules: See §10.4.10 

 Auxiliary measurements: See §10.4.11 

 Set file information: Allows the users to determine data fields that are attached to each scan 

 Use file information: Allows the user to change data within each field that is attached to each 

scan 

 New scan: Initiate new scan in a new scan window, given scan parameters in scan setup page. 

 Add scan: Initiate new scan given scan parameters in scan setup page, adding scan to active 

spectrum window. 

 

10.8.3 Tools 

 
Initialise:  Initialises the system using the configuration last selected 
 

Advanced Initialisation: The standard initialise button establishes communication with hardware 

based on a default system.cfg file (or the latest *.cfg file used on the computer). The advanced 

initialisation page permits definition in the first place of a specific *.cfg file to employ. 
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Figure 10.48: Advanced initialisation window 

 

Here can also be defined instrument group set ups and mode of operation. 

 

It is for example possible to define two groups of detection electronics, operated in ratiometer mode, 

or a wavelength switched system permitting for example the use of DC electronics in the ultraviolet 

and visible spectral regions, and AC electronics in the infra-red. 

 

Create custom wavelength file: When measuring for example a line source, rather than performing 

scans over the entire spectral range, full of barren land, it is possible to define a custom wavelength 

file limiting scans only to those regions of interest. 

 

 

Figure 10.50: Users can create a custom wavelength file in this window 

 

One can define a default step size, start and stop ranges, and add, insert or remove as appropriate. 

Having defined a custom wavelength file, save. This file might be implemented going to Scan → Scan 

Set Up and in Advanced>> selecting “Use custom wavelengths” and hitting the “Load custom 

wavelengths” button to select the appropriate file. 
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Schedule mode: Allows the user to determine an autonomous programme of scans. Upon loading a 

schedule they system will perform the measurements as directed in the schedule window 

 

Options: Relates to specific operation options of BenWin+. Certain recommended items are pre-

selected. 

 

  

Figure 10.51: Options window 

 

The default file locations may be modified by following the Folder link bottom left and use the “…” 

button to navigate to new folder location. 

 

 

Figure 10.52: Folder locations window 

 

10.8.4 Analysis 

 

Set spectrum names: See §10.5.2 

Overlay spectra: See §10.5.3 

Delete spectra: See §10.5.4 

Interpolate: See §10.5.5 

Cut: See §10.5.6 
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Concatenate: See §10.5.7 

Invert: See §10.5.8 

Normalise: See §10.5.9 

Spectral arithmetic: See §10.5.10 

Spectral average: See §10.5.11 

Quantum efficiency: See §10.5.12 

Peak picker: See §10.5.13 

Set spectral integral: See §10.7.14 

Calculate spectral integrals: See §10.5.14 

Calculate add-on measurements: See §10.4.11 

 

10.8.5 View 

 

Spectrum: See §10.5 

Spectral data: Hit this button to present the numerical spectral data to the right of the spectrum 

window 

Marker list: Shows presently set markers in right hand list 

Measurements: Shows spectral integral results in right hand list 

Vertical split: Position spectral data, measurements etc window to right of spectrum window 

Horizontal split: Position spectral data, measurements etc window under spectrum window 

Wavelength colours: §10.5.16 

Cursors: See §10.5.15 

Markers: §10.5.15 

Toolbars: Toolbars are as follows. 

 

Hardware  

 
Initialise | Configuration 

 

Main 

  
Open | Save | Copy spectral data | Print |Help 

 

Mouse Mode 

 
Cursor | Add text | Draw straight arrow | Draw curved arrow 

 

Scan 

  
Scan setup | Signal setup | Stationary scan setup | Signal monitor | Scan summary | Data corrections 

| Set reference | Add-on modules | Set averaging | New scan 
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Analysis 

  
Peak picker | Spectral integrals | Set spectrum names | Overlay spectra | Normalise 

 

View 

 
Spectrum view | CIE diagram | Spectrograph | Spectral data | Marker list | Measurements | Cursors 

 

Status bar: Lower screen status bar showing hardware mode, system status, current wavelength and 

dial reading 

 

Show auxiliary measurements: where a system is taking auxiliary measurements select to present or 

not the auxiliary measurement results 
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11. Device dependent detection 
 

11. 1 Overview 

 
In general, standard techniques require that the spectral response of solar cells be tested under light 

biasing at 1000 Wm-2 to simulate use conditions†. This presents the problem of discriminating the 

photocurrent generated by the monochromatic probe from that generated by the solar simulator. In 

most cases, this situation may be circumvented by optically chopping the monochromatic probe and 

recovering the AC signal with a lock-in amplifier having either a transformer or trans-impedance 

amplifier front-end. Whilst the former input stage is preferred- since it does not pass the DC signal, 

the AC signal can be given maximum possible gain- it only functions at elevated frequency, 

incompatible with certain types of cell. Indeed, in the case of certain DSSC cells, with particularly slow 

electron transport, recourse is made to the use of a DC monochromatic probe and detection. The 

following are the recommended routes for testing the solar cells of today. 

 

Probe source and signal detection operates in the AC regime permitting the use of a DC bias source to 

operate the device under test under standard conditions in the measurement of spectral response. 

 

There exists three methods of signal recovery; via a transformer, for those devices requiring the 

standard one sun bias, via a high current sink current amplifier, or via a high gain pre-amplifier for the 

measurement of less efficient devices, where higher sensitivity is required and where no or little bias 

shall be employed. 

 

With the addition of a few further elements, the presently unused monochromator port next to the 

dual light source may be used to permit the measurement of solar simulator irradiance. 

 

11. 2 Semiconductor and Organic Solar Cells 
 

474 Transformer & 496 Lock-in Amplifier 

 

The fast electron transport mechanisms in most semiconductor and some organic cells permit 

exploitation of the preferred transformer coupling method. 

 

The monochromatic probe beam is optically chopped at a frequency of 600 Hz and the cell under test 

illuminated with a one sun solar bias. 

 

The solar cell output is coupled by the 474 transformer, which passes only the optically chopped signal. 

This signal is amplified and passed to the lock-in amplifier. The device is operated under short circuit 

conditions. 

  

This technique is recommended for all semiconductor (c:Si, mc:Si, a:Si, µ:Si, CdTe, CIGS, CIS, Ge, 

tandem, multi-junction, quantum well, quantum dots) and some organic cells. 
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11. 3 Organic and DSSC Solar Cells  
 

477/498 Pre-amplifier & 496 Lock-In Amplifier 

  

Where device response is slow, recourse is made in the first instance to reduced chopping frequency 

and the use of a trans-impedance amplifier front-end to the lock-in amplifier. 

 

The monochromatic probe beam is optically chopped at a frequency of >10 Hz and the cell under test 

illuminated with one sun solar bias (or less to improve signal to noise). 

  

The solar cell output is passed through the 477 or 498 trans-impedance amplifier prior to being passed 

to the lock-in amplifier. The device is operated under short circuit conditions. 

  

This technique may be applied to organic and some DSSC cells.  

 

11. 4 DSSC Solar Cells 

 

498 and DC chopper 

  

Due to carrier transport mechanisms at play in DSSC cells, it may be found necessary to operate these 

cells at much slower chopping frequencies or in the DC regime. 

  

The monochromatic probe beam is either run DC or optically chopped up to 2Hz, and the cell 

illuminated with a reduced level of solar bias. 

 

The solar cell output is passed through a trans-impedance amplifier and the cell response recorded as 

a shutter in the dual source switches on and off the monochromatic probe. The device is operated 

under short-circuit conditions. 

  

This technique may be applied to DSSC technologies.  
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12. Measurement of Spectral Responsivity (Transformer) 
 

12.1 Introduction 

 

The measurement of spectral responsivity involves the comparison measurement of a detector of 

known responsivity with a device under test. 

 

To determine absolute (AW-1) responsivity, samples in both occasions must be underfilled by the 

probe beam, ie the light from the probe must be entirely seen by the detector. 

 

If this is not the case, only measurements of relative spectral response can be performed. 

 

With the calibrated detector underfilled and knowing its AW-1 responsivity, one can effectively 

determine the optical power in the beam. 

 

Measuring then the photocurrent response of the device under test one can determine the 

responsivity of the latter, and from there the quantum efficiency. 

 

12.2 System setup 

 
 Ensure USB connected 

 Power on the Xenon source 610 

 Power on all remaining devices after red lamp failed light of Xenon source extinguishes 

 Let lamps warm up for ten minutes 

 

 

12.3 System calibration 
 

 Run BenWin+, select Transformer mode 

 Ensure reference detector connected via the thick, short BNC cable, to the input of the 

transformer, the output of the transformer to the input of the 474 amplifier and the output 

of the 474 amplifier to input 2 of the 496 lock-in amplifier  

 To position reference detector central to the beam, go to wavelength box and input visible 

wavelength (eg. 555nm) 

 Go to Scan → Scan setup 

 Define start, end and step wavelengths, for example 300-1100nm in steps of 5nm 

 Go to advanced>>, ensure that data correction is NOT selected 
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12.1: Scan setup page with settings used for the initial calibration measurements 

 

 Hit new scan 

 The y-axis should read signal (nA) 

 At the end of the scan, save, giving appropriate name 

 Multiple scans can be performed, the average taken using the function in the Analysis menu, 

and all but the average spectra deleted using this analysis menu item 

 Save result 

 Calibrate the system 300-1100nm with the silicon detector and 800-1800nm with the 

germanium detector, ensuring that where a calibration over the full range is required, an 

overlap region is provided 

 

12.4 Applying calibration 

 

Where the measurement range encompasses the range of only one reference detector, to implement 

data correction: 

 

 Go to Scan → Data correction 

 For certificate file load .bcf file of calibrated detector 

 For system file, select just saved measurement 
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12.2: Data calibration window 

 

 Hit calculate calibration data 

 On prompt say YES to the application of data correction 

 For future use, hit save to file, and give appropriate name 

 

Where the measurement range encompasses the range of both reference detectors, to implement 

data correction: 

 

Go to Utilities → Correction Calculator 

 

 

Figure 12.3: Correction Calculator window 

 

For spectrum 1: 

• Load measurement of silicon detector (300-1100nm) 

• Load certificate of silicon detector 
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For spectrum 2: 

• Load measurement of germanium detector (800-1800nm) 

• Load certificate of germanium detector 

 

Set absolute spectrum as spectrum 1. 

 

One of the correction factors are taken as absolute, the other normalised to ensure a continuous 

correction function. Given the larger area of the silicon diode it is more likely that the beam power 

measurement be performed correctly with this device. 

 

 Hit show overlap 

 The correction curves for both devices are shown in the overlap region and there deviation 

noted 

 Typically the crossover point is taken automatically ~950nm. Given the reduction of response 

of silicon in the region of its band edge, this is the most stable location 

 Hit save to file 

 Go to Scan → Data Correction 

 Hit load from file 

 Load just-saved correction file 

 On prompt say YES to the application of data correction 

 

 

12.5 Measurement of solar cells 

 

From the above, the system is now calibrated in spectral responsivity. 

 

 Ensure sample device connected via the thick, short BNC cable, to the input of the 

transformer, the output of the transformer to the input of the 474 amplifier and the output 

of the 474 amplifier to input 1 of the 496 lock-in amplifier  

 Position sample cell, using lock-in amplifier page to select wavelength, to check position with 

respect to probe beam 

 Check phasing of lock-in amplifier 

 

Where the use of a bias source is required, go to utilities → PV bias control to switch on/off as required: 
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Figure 12.4: PV bias control 

 

 Perform spectral scans ensuring data correction selected 

 Save results with appropriate name 

 

 

12.6 Results analysis 

 
At the end of the scan, one is presented with the spectral responsivity of the device, such as: 

 

 

Figure 12.5: Detector responsivity and external quantum efficiency 

 

If desired, one can inspect the (external) quantum efficiency of the device by going to the Analysis → 

Quantum Efficiency menu item. One can return to the responsivity view via Analysis → Detector 

Responsivity. Do not forget to save the device results. 
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13. Measurement of Spectral Responsivity (498 Preamplifier-AC 

mode) 
 

13.1 Introduction 

 

When the response of the cell is slow it may be useful to use this mode as the probe beam can be 

chopped to as little as 10 Hz. Please note that the 498 amplifier saturates at 100mA, and should 

therefore be used with little or no bias. 

 

It should be further noted that the 498 is a DC and AC amplifier, the presence of a large DC bias-

generated photocurrent will lead the amplifier to operate on a low gain level, which means of course 

that the probe signal shall receive little gain and the signal to noise ratio shall deteriorate. 

 

13.2 System setup 

 
 Ensure USB connected 

 Power on the Xenon source 610; the lamp failed light shall show whilst the starter circuit is 

charging, and extinguish when the lamp illuminated 

 Power on all remaining devices after red lamp failed light of Xenon source extinguishes 

 Let lamps warm up for ten minutes 

 

13.3 System calibration 

 

 Run BenWin+, select 498 AC mode configuration 

 Ensure reference detector connected directly to input one of the 498 amplifier and the output 

of this to input 1 of the 496 lock-in amplifier 

 Users can then follow the instructions detailed in §12.3  

 

13.4 Applying calibration 

 
The process of applying the calibration should be the same as the process described in §12.4 

 

13.5 Measurement of solar cells 

 

Users can then follow the same instructions as §12.5. Please note that the PV bias should not be used 

in this mode 

 

13.6 Results analysis 

 

Again users should follow the steps detailed in §12.6 

  



 

Page 93 

 

14. Measurement of spectral responsivity (498 Amplifier/ADC-DC 

mode) 
 

14.1 System setup 

 

• Ensure USB connected 

• Power on the xenon source 610; the lamp failed light shall show whilst the starter circuit is 

charging, and extinguish when the lamp illuminated 

• Power on all remaining devices after red lamp failed light of Xenon source extinguishes 

• Let lamps warm up for ten minutes 

• Power off optical chopper on 218M module 

 

14.2 System calibration 
 

• Run BenWin+, select 498 DC mode configuration 

• Ensure reference detector connected directly to input one of the 498 amplifier 

• Following this, the procedure is the same as stated in §12.3 

 

14.3 Applying calibration 

 
To apply the calibration users should follow the instructions detailed in §12.4 

 

14.4 Measurement of solar cells 

 

From the above, the system is now calibrated in spectral responsivity and users can now measure the 

cell 

 

 Ensure device under test connected directly to input 1 of the 498 amplifier  

 Users can then follow the instructions detailed in §12.5 

 

14.5 Results analysis 

 

To analyse the results the user can follow the instructions described in §12.6 
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15. Measurement of Reflectance 
 

15.1 System setup 

 
 Ensure USB connected 

 Power on the Xenon source 610 

 Power on all remaining devices after red lamp failed light of xenon source extinguishes 

 Let lamps warm up for ten minutes 

 Run BenWin+, select 498 AC high-sensitivity configuration 

 Connect detector via interface panel to 498 input 1 

 Go to scan → signal setup 

 For target wavelength choose 0nm 

 Move the 45° mirror fully to the right so that light enters the sphere, then fix in place 

 Placing the reflectance standard at the reflectance sample port, adjust sphere position to 

obtain probe focussed at this plane, fix in place sphere 

 Depending on spectral range of consideration, mount silicon/germanium sandwich detector 

at detector port 

 

15.2 System calibration 
 

 In Scan → Reference setup, ensure “use reference setup” not selected 

 In Scan → Scan Setup → advanced ensure that data correction is not selected 

 Go to Scan → Scan setup 

 Place reflectance standard at sample port 

 Ensure SPIN/SPEX trap has reflectance plug in place 

 Ensure detector connected directly to input one of the 498 amplifier and the output of this to 

input one of the 496 lock-in amplifier. 

 Go to Scan → Scan Setup 

 Define start, end and step wavelengths, for example 300-1100nm in steps of 5nm 

 Go to advanced>>, ensure that data correction is NOT selected 
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Figure 15.1: Scan setup window with settings used for initial scan of the reflectance piece  

 

 Hit new scan 

 The y-axis should read signal (nA) 

 At the end of the scan, save, giving appropriate name 

Multiple scans can be performed, the average taken using the function in the Analysis menu, and all 

but the average spectra deleted using this analysis menu item. Save result. 

 

15.3 Applying calibration 

 

This is implemented via the reference setup. To implement correction: 

 

 Go to Scan → Reference setup 

 

 

Figure 15.2: Reference setup window used in reflectance measurements 

 

 Select reflectance 

 Select ratio 

 For measured reference, hit … button to load just saved file 
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 For calibrated reference file name, hit … button and load calibration values of reflectance 

standard 

 Check the “use reference calculation” box 

 Return to scan setup proceed to measure 

 

15.4 Measurement of Reflectance of Solar cells 

 

From the above, the system is now calibrated in SPIN reflectance. 

 

 Place the sample to test at the reflectance sample position 

 Perform scan over the required spectral region 

 Save results with appropriate name 

16. Measurement of Transmittance 
 

16.1 System setup 

 

 Ensure USB connected 

 Power on the Xenon source 610 

 Power on all remaining devices after red lamp failed light of Xenon source extinguishes 

 Let lamps warm up for ten minutes 

 Run BenWin+, select the 498 AC high-sensitivity configuration 

 Go to Scan → Signal Setup 

 For target wavelength choose 0nm 

 Probe beam shall be transmitted to PVE300 chamber 

 Displace 45° mirror to relay light toward DTR6, fix in place 

 Placing a target at the entrance port, adjust sphere position to obtain probe focussed at this 

plane, fix in place sphere 

 Depending on spectral range of consideration, mount Silicon or Germanium detector at 

detector port 

 Connect detector via interface panel to 498 input 1 

 Place reflectance standard at reflectance port to close this aperture 

 

16.2 System calibration 
 

Users should follow the steps described in §15.2 

 
16.3 Applying calibration 

 
To implement the calibration via the reference setup, users should follow the steps shown in §15.3 
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16.4 Measurement of the Transmittance of Solar Cells 

 

From the above, the system is now measured in terms of transmittance. TO perform this users should 

follow §15.4 

 

16.5 Results analysis 

 

Based on the results of transmittance and reflectance, the EQE may be modified to determine the IQE 

via the following: 

 

𝐼𝑄𝐸 =
𝐸𝑄𝐸

1 − 𝑅 − 𝑇
 

 

Where IQE and EQE are in absolute units or percent, and the reflectance, R, and the transmittance, T, 

are in absolute units. A utility exists to permit the calculation of the IQE, in Utilities → EQE IQE 

Calculator. 

 

 

Figure 16.1: EQE IQE Calculator 
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17. Precautions & Troubleshooting  

 
17.1 Precautions 
 

This section deals in the first instance with those precautions that should be observed in using this 

system, then with the cases where something goes wrong  

 

The following is a list of specific precautions aimed to preserve for good use this system. 

 

Light Source 

 Ensure correct bias applied to correct lamp at all times 

 It is recommended to power on the Xenon lamp first before all other electronics 

 

Monochromator 

 Do not touch gratings nor optics 

 Do not subject monochromator to violent physical shock- this may invalidate wavelength 

calibration 

 Always switch on Xenon sources prior to monochromator 

 

17.2 Trouble Shooting 

 

The following is a list of some more common problems encountered with spectroradiometer systems, 

by no means exhaustive, please contact Bentham should any other problem arise. 

 

Problem Possible Error/Solution 

“Jumps” seen in spectra at 

decades 

Ensure zero-calibration is selected 

On scanning no signal seen Ensure detector connected to 487 

Ensure correct channel used. 

BenWin+ does not initialize Ensure all units switched on and USB 

connection OK 

Nonsensical scan obtained Ensure data correction switched on/off as 

appropriate 

Ensure reference calculation on/off as 

appropriate 
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Appendix 1: Verification of Monochromator Wavelength Calibration 
 

Wavelength calibration is usually checked using a mercury lamp the output of which consists of 

discrete lines at defined wavelengths. The presence of mercury in overhead fluorescent tubes can act 

as a good replacement for a specific lamp. 

 

The following describes calibration with a mercury lamp but in the case of this system, the same can 

be performed using the emission lines from the xenon lamp, or by simply viewing the zero order 

contribution of each grating in turn. 

 

The following table shows the position of the mercury lines. Those marked in red are particularly 

strong lines, leading therefore to higher orders with a measurable contribution.  

 

 

Table A1.1: Xenon lines along with their nth order 

 

It is of course important to ensure that whilst observing the higher order lines, the order sorting filters 

of the monochromator are de-activated. This is done by going to Instruments → Filter wheel and 

resetting the true insertion wavelengths with 0nm. 

 

Use the Tools → Create Custom Wavelength file facility of BenWin+ to define a scan around desired 

emission lines rather than scanning over the full range. 

 

Go to Tools → create custom wavelength file, to view the following, left. Set default step size, insert 

the number of lines required, double click on values to edit and finally save to file.  

 

Choose a step size of minimum 0.15nm to view lines. Scans using this file are initiated by going to Scan 

→ Scan Set, select custom wavelength file and load file required, then scan as normal. 

 

1st Order 2nd Order 3rd Order 4th Order 5th Order 6th Order 7th Order

184.91

194.17

226.22

237.83

248.2

253.65 507.3 760.95 1014.6 1268.25 1521.9 1775.55

265.2

280.35

289.36

296.73

302.15

312.57 625.14 937.71 1250.28 1562.85

313.17

334.15

365.02 730.04 1095.06 1460.08 1825.1

365.44

366.33

404.66 809.32 1213.98 1618.64

407.78

434.75

435.84 871.68 1307.52 1743.36

491.6

496.03

546.07 1092.14 1638.21

576.96

579.07

690.7

1013.98
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Please be aware of the slits presently in system. Having for example 5nm slits present and looking at 

the lines around 365nm, one will effectively see several lines which can distort the result and wrongly 

show lack of calibration. 

 

In the case of infrared gratings where this procedure is of no use, gratings are set up with the zero-

order position. 

Appendix 2: Electrical Connection for Transformer Configuration 
 

 

  

Appendix 3: Electrical Connection for 498 Pre-Amplifier AC 

Configuration 
 

 

 

Appendix 4: Electrical Connection for 498 Amplifier-ADC DC 

Configuration 
 

 
 

Appendix 5: Dual Light Source Lamp Replacement 
 

Xenon Lamp Replacement 

 Remove the lid of the dual light source by removing the 8 screws that hold the lid onto the 

source, the lid can then be removed 

 Undo the grub screw that holds the top of the bulb in the brass holder. This will release the 

top of the bulb  

 

Transformer 
Input via thick 

BNC 
 

496 
Input 2 

474 Input Reference 
detector/device 

under test 
 

498 
Input 1 

 

496 
Input 1 

Reference 
detector/device 

under test 
 

498 
Input 1 

 

Reference 
detector/device 

under test 
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A5.1: Grub screw that releases the top of the xenon lamp 

 

 Gently pull the bulb out of the brass holder and place it so that the top rests on the floor of 

the source, by the xenon mirror. Now undo the screw that holds the base of the bulb to the 

main support 

 The bulb can now be removed from the source entirely. Rest the bulb on a soft surface and 

gently release the wired collar from the base of the bulb 

 The new bulb can now be inserted following the reverse procedure. Ensure that polarity is 

observed, and that the collar is placed onto the correct end of the bulb 

 

 

A5.2: Remove this screw to remove the cable connecting the xenon lamp  

 

Alignment of Xenon Lamp 

 The system should be started up in reflection mode (using the 498 and 496), but with the 

silicon detector (DH-Si) connected rather than the sphere and the mirror which deflects the 

beam towards the sphere out the way so that the beam falls onto the DH-Si. 

 Now the system is set so that the probe beam strikes the silicon detector. To do this the lock-

in amplifier page is opened by opening the Instruments → Lock in amplifier page from the top 
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of BenWin+. The wavelength is set to 555nm and the “Start” button is pressed so that the 

probe beam is falling onto the DH-Si. There will now be values in Channel 1, Channel 2, theta 

and resultant.  

 The bulb can now be aligned until this resultant value is as high as possible. There are 2 

alignments to be performed on the bulb which should be repeated until the resultant is as 

high as possible.  

 

The 2 alignments are the height of the bulb and the tilt of the bulb. These 2 are controlled in the 

following way. 

 

Height: At the top of the light source is a central screw held in place with a nut onto the central 

aluminium bar (red circle). This nut can be loosened so that an Allen key can be inserted in the top of 

the grub screw. As this grub screw is rotated the bulb will be moved vertically in the mount. The 

resultant value should be watched and the height of the bulb adjusted until this is a maximum value.  

 

Tilt: There are three other grub screws present which screw directly into the brass block (blue circles). 

Each of these adjusts the tilt of the xenon bulb. Each of these should be adjusted so that a maximum 

resultant value is seen. It may be found that after all 3 have been adjusted, the first can be adjusted 

further to gain even more signal, therefore this process should be done iteratively until no more gain 

in signal can be achieved.  

 

 

A5.3: Grubs screws used to adjust the height (red) and tilt (blue) of the xenon lamp 

 

Both the height and tilt alignments should be done iteratively until no more signal can be gained. The 

xenon bulb signal should finally be roughly 4 times higher than the Quartz Halogen signal. Once 

complete the nut on the height control should be tightened. 

 

Quartz Halogen Lamp Replacement 

Replacement of the quartz halogen (QH) lamp is a relatively easy procedure. Simply remove the 

expended lamp and replace with a new 100W lamp. There is no need to observe polarity on the lamp. 
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Alignment of the Quartz Halogen Lamp  

The QH lamp should be fitted such that the slits of the monochromator are centrally located on the 

image of the filament. Although under normal circumstances, there is no need to focus the lamp as 

this should already be set. However, should users need to, undoing the grub screw that secures the 

lens and then move this back or forward until the signal is maximised in the same way as the xenon 

lamp.  

 

  

A5.4: Moving the QH lamp left or right allows the user to centre the filament on the slits, while the lens allows focussing 

 

Appendix 6: Overview of System Installation 
 

The following notes provide the user with a guide to the installation of the PVE300 system. 

 

Shipped Items 

The measurement enclosure with monochromator, light source, relay optic and bias light source is 

shipped as a single unit in a wooden crate. Power supplies, vacuum mount, detection electronics, 

integrating sphere, detectors and accessories are packaged separately. 

 

As a guide, the anatomy of the system, is provided overleaf. 

 

PVE300 Enclosure  

Site the main PVE300 enclosure in a suitable location. On optical bench is not required. For the 

moment the only addition to the enclosure is to find the power supply with 3-pin connector for the 

LED illumination of the chamber; connect to mains and connect 3-pin to socket in right hand wall of 

PVE300 

 

Power Supplies 

Two power supplies are required for the dual light source and one for the solar simulator. The 610 

power supplies current is set via a key switch with the etched arrow pointing to the set current. These 

are pre-set and the key kept to the side for safe keeping. 
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Place the 610s set to 8.500A and 5.400A to the left hand side of the enclosure (dual light source), and 

that set to 6.300A to the right hand side of the enclosure. 

 

Detection Electronics 

Place the detection electronics on top of the 610 to the right hand side of the enclosure 

 

Electrical Connections 

 Locate red and black cables to connect 610 to light sources 

 Connect 610 set to 8.500A to the quartz halogen lamp in the dual source 

 Connect 610 set to 5.400A to the Xenon lamp in the dual source 

 Connect 610 set to 6.300A to the solar simulator to the right of the enclosure 

 Connect black 3-pin connector cable between fan input on dual source and either of the dual 

source power supplies 

 Connect black 3-pin connector cable between fan input on solar simulator and its power 

supply 

 Connect black 3-pin connector cable between SAM port on dual source and SAM port on left 

hand side of monochromator 

 Connect black 3-pin connector cable between SAM port on solar simulator and SAM port on 

right hand side of monochromator 

 Connect black 5-pin connector cable between chopper input on dual source and 218M output 

of the 417 detection electronics 

 Connect output of transformer, through the interface panel on right hand wall of enclosure, 

to the input of the low noise amplifier with thin BNC cable 

 Connect short piece of thick BNC cable to input of transformer- to be connected to either 

reference detector or electrical probe 

 Connect USB between controlling computer and monochromator (windows will recognise on 

power-on) (pass from rear under monochromator) 

 Connect USB between controlling computer and detection electronics (windows will recognise 

on power-on) 

 Connect mains to monochromator (pass from rear under monochromator), detection 

electronics and power supplies 
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A6.1: PVE300 setup 

Dual light source having xenon and 
quartz halogen sources, a swing away 
mirror (SAM), a fan and an optical 
chopper 

Three constant current lamp power 
supplies 

Mirror-Based Relay Optic 

Detection electronics 

DTR6 Integrating Sphere 

Silicon and Germanium 
reference detectors with metal 
spacer “cup” 
 

TMc300 Monochromator 

Transformer 

Solar simulator with six-fibre bundle 

Vacuum mount with probes and 
temperature control from VC-TE-30 

PVE300 Chamber 
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DTR6 Integrating Sphere 

 Mount silicon/germanium detector to detector port using screws provided (lower port in 

picture below) 

 Mount sphere to optical rail in chamber as shown below, clamp in place 

 

 

Figure A6.2: DTR6 and 45° Mirror 

 

Vacuum Mount 

 

 

Figure A6.3: PVE mount 

 

The 200x200mm vacuum mount is mounted on a stand for placement of the electrical probes. 

 

Vacuum points are disposed in a cross formation to improve thermal contact during operation. 

“Pennies” are provided to stop unused holes where required to improve the vacuum. 

 

Below the stage are situated the temperature-controlling Peltiers with the associated water cooling 
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of the latter. To the rear of the device is located a port for the vacuum air feed and two circulation 

ports for the water cooling system.  

 

 Locate the vacuum mount in the chamber 

 Locate the VC-TE-30 to the right hand side of the chamber. If stacking the electronics, it is 

recommended to place this unit to the bottom to avoid water spilling over other electronics 

 

 

Figure A6.4: Front panel of VC-TE-30 

 

The VC-TE-30 houses the water cooling controller, the drive to the Peltiers and a vacuum pump. An 

on-off switch is located to the rear of the unit next to the mains input. At the front are two ports for 

the water re-circulation system, a reservoir, a vacuum port, and electrical connection to the Peltier 

devices. 

 

A toggle switch powers off/on the water circulation, vacuum and the temperature control. A 

protection mechanism prevents the temperature control to be powered on without water circulation.  

 

A front panel LCD display shows the current and target temperature of a transducer situated inside 

the mount. Below the LCD a toggle switch switches the view of the LCD between target and actual. 

The target temperature can be modified by pulling out the black knob, modifying the set point, and 

locking the position by pushing back in the knob. 

 

To set up the mount: 

 Locate clear piping 

 The vacuum port on the mount is the upper port- it should be connected to the vacuum port 

of the VC-TE-30 through the right-wall interface plate 
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Figure A6.5: Rear of the mount showing the connection to the vacuum 

 

 The Peltier electrical control should be connected to the VC-TE-30. Note that the intermediate 

connection should be attached to the wall of the PVE300 system 

 The water re-circulation ports should be connected each to the VC-TE-30 providing input and 

output to the mount. 

 

     

Figure A6.6: (l) Water flow into the mount and (r) Peltier intermediate connection 

 

There should remain some water in the mount so getting the system running should be easy. Have 

ready distilled water and remove the lid from the reservoir. Power on the VC-TE-30 and power on the 

water flow for short periods, say 20 seconds. Top up the reservoir ass required as air in the circuit is 

replaced with water. Rock the VC-TE-30 and the mount gently to help rid of air locks therein. When 

the system is free of air locks, no significant bubbles should be seen inside the reservoir. 

 

Electrical Probes 

Locate the probes on the pedestal to the side of the vacuum mount; two probes are provided, with 

output via BNC. Should the mount be used as the ground plane, a fly lead permits connecting the 

probe to a grounding point on the mount, the probe connecting to the other pole of the device under 

test. 
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Figure A6.7: (l) Earth connection on the rear of the mount and (r) earth connection to probe for front to rear connections 

 

Where the device under test is insulated from the mount, two probes are required. In this instance, 

the fly lead should connect both probes, and a stub should be placed on the BNC port of the second 

probe to short the probe to the opposite pole of the BNC. 

 

 

Figure A6.8: Earth connection between two probes for front to front connections 

 

Software 

 Insert BenWin+ CD into computer and let autorun open 

 Install BenWin+ or select from drive setup.exe 

 Hit OK to end 

 Copy from calibration certificate CDs the bcf files of each calibrated detector and paste in 

c:\Program Files (x86)\Bentham\Benwin+\Calibration 

 Starting Up System 
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System Start Up  

There is no particular start up sequence save from the suggestion of powering on the xenon lamp first. 

On power on, the red lamp failed light illuminated whilst the starter circuit charges up. After thirty 

seconds, the arc is struck and the lamp operates. It is possible, but very unlikely, that interference 

from this start up procedure damages live electronics. As a precaution powering on and waiting for 

the start of this lamp before powering on the rest of the system avoids any doubt. There is no 

particular order for power-down. 

 

The system is now ready for measurement for examples see section 11.
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Guarantee 
 

 

BENTHAM INSTRUMENTS warrants each instrument to be free of defects in material and workmanship 

for a period of one year after shipment to the original purchaser. Liability under this warranty is limited 

to repairing or adjusting any instrument returned to the factory for that purpose. 

 

The warranty of this instrument is void if the instrument has been modified other than in accordance 

with written instructions from BENTHAM, or if defect or failure is judged by BENTHAM to be caused 

by abnormal conditions of operation, storage or transportation. 

 

This warranty is subject to verification by BENTHAM, that a defect or failure exists, and to compliance 

by the original purchaser with the following instructions: 
 

1. Before returning the instrument, notify BENTHAM with full details of the problem; including 

model number and serial number of the instrument involved. 

 

2. After receiving the above information, BENTHAM will give you shipping instructions or service 

instructions. After receipt of Shipping instructions, ship the instrument “carriage paid” to 

BENTHAM. Full liability for damage during shipment is borne by the purchaser. It is 

recommended that instruments shipped to us be fully insured and packed surrounded by at 

least 2 inches of shock-absorbing material. Specific transit packaging as used in 

monochromators etc. must be installed. 
 

BENTHAM reserves the right to make changes in design at any time without incurring any obligation 

to install same on units previously purchased. 

 

This warranty is expressly in lieu of all other obligations or liabilities on the part of BENTHAM, and 

BENTHAM neither assumes, nor authorises any other person to assume for it, any liability in 

connection with the sales of BENTHAM’S products. 
 

BENTHAM INSTRUMENTS LTD 

2, Boulton Road 

Reading 

Berkshire 

RG2 0NH 

England 

Tel: +44 (0)118 975 1355 

Fax: +44 (0)118 931 2971 

Email: sales@bentham.co.uk 

 

NOTHING IN THIS GUARANTEE AFFECTS YOUR STATUTORY RIGHTS 
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WEEE statement 

 

Bentham are fully WEEE compliant, registration number is WEE/CB0003ZR. Should you need to 

dispose of our equipment please telephone 0113 385 4352 or 4356, quoting account number 135419.

 


